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Preface

This Implementation Guide provides information and instructions to help you 
implement Oracle Sales Online, Release 11i.

This preface explains how the guide is organized and introduces other sources of 
information that can help you.

Introduction to Oracle Sales Online
Oracle Sales Online is an HTML based application which provides sales managers, 
sales representatives, and sales executives assistance in managing their business 
opportunities, customers, forecasting, incentive compensation, partners, and quotes. 
Sales Online enables the management of business data using the Trading 
Community Architecture (TCA) customer model. TCA enables Sales Online to 
support complex relationships which further allows Sales Online users to provide 
exceptional service to customers. Sales Online is integrated with Oracle TeleSales, 
Oracle Marketing Online, Oracle Partner Relationship Management, and Oracle 
Incentive Compensation.

Intended Audience
This guide describes how to set up and configure Oracle Sales Online. The intended 
audience includes system administrators and Oracle implementation consultants. 
This is not meant to be a user’s guide.

Related Documentation and Resources
The following documents provide additional information on installing and 
implementing Oracle CRM products. 
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Reference Documentation

Installing Oracle Applications, Release 11i 
This manual documents the Rapid Install installation process.

Oracle Applications Concepts 
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. 

Oracle Applications Flexfield Guide 
This guide contains information about using Oracle Flexfield features. It also offers 
flexfield implementation suggestions.

Oracle Applications Product Update Notes, Release 11i 
This document contains information about new product features and functions for 
various Oracle applications.

Oracle Applications System Administrator’s Guide 
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage processing. 

Oracle Applications User’s Guide
This guide explains how to customize lists of values (LOVs) in the system, enter 
data, and introduces other basic features of the GUI available with Oracle 
Applications Release 11i.

Additional Product-Related Documentation

Implementing CRM Applications 
This document provides instructions for completing installation of Oracle Customer 
Relationship Management (CRM) products.

Implementing Oracle HRMS 
This document provides the information necessary to implement Oracle HRMS.
x



Oracle CRM Foundation Implementation Guide 
This guide describes set up and configuration tasks for all the foundation 
components.

Oracle CRM Foundation Technical Reference Manual 
This manual contains table and view descriptions for all the Oracle CRM 
foundation components.

Oracle Inventory User’s Guide
This guide contains information about product features and functions for Oracle 
Inventory.

Oracle Marketing Concepts and Procedures 
This document is a printed compilation of the Oracle Marketing online help system, 
including implementation information. 

Oracle Marketing Encyclopedia Concepts and Procedures
This document is a printed compilation of the Oracle Marketing Encyclopedia 
online help system.

Oracle Order Capture Concepts and Procedures 
This document is a printed compilation of the Oracle Order Capture online help 
system. 

Oracle Sales Compensation Implementation Guide 
This guide describes set up and configuration tasks required to implement Oracle 
Sales Compensation.

Oracle Sales Online Technical Reference Manual 
This manual contains table and view descriptions for Oracle Sales Online.
xi



Documentation Accessibility
Oracle’s goal is to make our products, services, and supporting documentation 
accessible to the disabled community with good usability. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our doucmentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program web site at http://www.oracle.com/accessibility/.
xii
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  Implementing Oracle Sales Online

Overview of Oracle Sales Online
Oracle Sales Online is an HTML-based application for use by field sales 
representatives, sales managers, and sales executives. The Oracle Sales Online web 
architecture enables global deployment, painless upgrades for remote users, and 
fast and easy customization.

Overview of Functionality
Sales Online functionality includes the following:

Customer and Contact Management
Sales Online provides sales representatives with a complete customer overview at 
each stage of the sales process, in both Business to Business and Business to 
Customer environments. Before contacting a customer, a sales person can review 
customer information including: products installed, outstanding service requests, 
payment history, key relationships, open opportunities, and interaction 
history-customer touch points. Comprehensive customer information allows 
salespeople to better manage their customers and to plan each customer interaction 
more efficiently.

Understanding Trading Community Architecture
The Sales Online customer model is based on the Trading Community Architecture, 
also referred to as TCA. Trading Community Architecture is an architecture 
designed to support complex trading communities. The goal of TCA is to provide 
the foundation for Oracle Enterprise Resource Planning (ERP), Customer 
Relationship Management (CRM), and eBusiness applications, (i.e., the entire 
eBusiness Suite). To do this, TCA strives to model all relationships within a ’trading 
community’. For example, the trading community of an appliance manufacturer 
Implementing Oracle Sales Online 1



Overview of Oracle Sales Online
may include suppliers, distributors, resellers, retailers, service providers, individual 
consumers and business consumers. The appliance manufacturer not only wants to 
track relationships between itself and other entities within the trading community, it 
is also interested in relationships that other community members have with each 
other. The appliance manufacturer may not even have direct relationships with all 
the members of its trading community. But, it is important that the appliance 
manufacturer know about these entities and how they relate to others within the 
trading community.

Within Sales Online, all business entities are treated equally. This allows Business to 
Business, Business to Consumer, and mixed business models to be supported 
equally. People are both customers and business contacts. The definition of a 
business contact is a person who has a relationship (usually an employee/employer 
relationship) with the organization with which you are selling. The definition of an 
organization is a business entity that has attributes similar to an organization, i.e., 
an SIC (Standard Industry Code), DUNS (Dunn and Bradstreet) number, or tax 
identification number.

Opportunity Management
Account managers, sales managers, and territory managers can use Sales Online to 
analyze their pipelines. Sales Online can be used to obtain real time reports 
summarizing their groups’ pipeline.

Opportunity and Product Category Forecasting
Forecasting is a quantitative tool used to predict the amount of sales for a specified 
time period. Forecasting can be used by managers and salespeople to commit to the 
amount of sales that they will close by the end of the forecasting period. 

The following table details the forecasting levels available in Sales Online:

Forecasting levels

Level How it works

Product 
Category

Forecasting at the Product Category level provides salespeople 
with an easy way to forecast their sales at the product level by 
rolling up opportunity lines into product groupings. From the 
summary page, Pipeline value links take you to the Forecast 
Summary by Product Category report.
2 Oracle Sales Online Implementation Guide 



Overview of Oracle Sales Online
Managers can create their own views of their sales representatives’ forecasted 
opportunities and can track forecast adjustment history.

Notes, Tasks, and Attachments
Sales Online users can create notes and attachments and link them to opportunities, 
organizations, relationships, people, and forecasts. By clicking an attachment link, 
you will launch the corresponding application automatically. Notes are limited to 
2,000 characters. Attachments include; Universal Resource Locators (URLs), free 
form text, and standard format files.

Users can create and assign tasks to themselves or other sales team members. Tasks 
are displayed on the Activity tab’s summary page. You can personalize the page 
through the Activity profile preferences. 

Interaction Management
Sales Online users have visibility into all customer touch points through integration 
with the CRM Foundation module. Interaction History displays interactions 
conducted by other systems and/or individuals.

Quote Management
Oracle HTML Quoting is an electronic commerce application which provides a 
Web-based interface for assisted selling of products and services to customers and 
business partners. Oracle HTML Quoting enables the easy creation, management 
and personalization of customer quotes in a secure environment. With seamless 
integration to Oracle Enterprise Resource Planning (ERP) Applications and other 
Oracle Customer Relationship Management (CRM) Applications, Oracle HTML 
Quoting enables companies to provide optimum customer service during the 
campaign and sales processes.

Opportunity Forecasting at the Opportunity level provides a tool for 
salespeople to create their own view and commitment of the 
opportunities that they or their sales representatives are 
working on. At this level, a manager can review, adjust, and 
commit to the numbers used in forecasting at the 
opportunity level.

Level How it works
Implementing Oracle Sales Online 3



New in this Release
Partner Management
Users can now take advantage of the expanded definition of partner relationships 
and integration with Oracle Partner Relationship Management for indirect selling 
channels. And, using an exchange server, users can use Opportunity Exchange for 
co-selling.

Incentive Compensation
Integration with Oracle Sales Compensation enables Sales Online to align sales force 
behavior with business goals and imperatives.

Sales representatives can view their compensation summary and break down their 
commissions by deal, product line, period, adjustments, and transactions.

Salespeople can also estimate their commissions with Income Planner by using their 
submitted forecast as the baseline.

Through Quota Planning, sales managers and executives can plan and distribute 
quotas to different sales groups and/or professionals through a simple HTML 
interface.

Collateral Fulfillment
Through integration with the Oracle CRM Foundation 1-to-1 Fulfillment 
component, users can send collateral to their contacts and prospects.

Marketing Encyclopedia System
Through integration with the Oracle Marketing Encyclopedia System, sales and 
marketing professionals can organize corporate information into categories and 
channels for use by the sales force. Marketing Encyclopedia System users can set up 
groups to swiftly publish content to the appropriate audience.

New in this Release
The following new features have been added to Sales Online in this release.

Customer Enhancements
The relationship detail page can display multiple relationship addresses. 
Additionally, organization detail pages now display both Active and Inactive 
relationships which you can customize. You can also enter the Standard Industry 
Code (SIC) and SIC type on the organization detail page.
4 Oracle Sales Online Implementation Guide 



New in this Release
Tasks Enhancement
Users can now add start and end times to their tasks. 

Quotes
Oracle HTML Quoting is an electronic commerce application which provides a 
Web-based interface for assisted selling of products and services to customers and 
business partners. Oracle HTML Quoting enables the easy creation, management 
and personalization of customer quotes in a secure environment. With seamless 
integration to Oracle Enterprise Resource Planning (ERP) Applications and other 
Oracle Customer Relationship Management (CRM) Applications, Oracle HTML 
Quoting enables companies to provide optimum customer service during the 
campaign and sales processes.

If iStore is installed, Sales Online users can create, view, and copy quotes. For 
information about creating, maintaining, searching quotes, and configuring quote 
line items, please refer to the Oracle HTML Quoting Concepts and Procedures guide.

Forecasting Enhancements
Sales Online has enhanced forecasting functionality that includes to include; 
Forecast Dates on Opportunity Lines and other forecast streamlining enhancements. 
This version of Sales Online introduces the concept of a forecast date for each 
opportunity line. This will allow salespeople to create one opportunity and 
distribute the opportunity into multiple forecast periods

Salespeople are able to automatically generate product category and opportunity 
worksheets through new forecasting functionality. 

Resource Team Enhancement
Users are now able to select Resource Teams to add to Sales Teams. This allows 
users to quickly add multiple salespeople to a sales team.

Online Territory Assignment Program
The Territory Assignment Program (TAP) allows administrators to assign 
opportunities and customers to salespeople based upon territory set up. Until this 
release, this functionality was available only in batch mode, now territory 
assignment is available online. Opportunities and customers are automatically 
assigned when they are created or updated.
Implementing Oracle Sales Online 5



Dependencies
Application Architecture
Oracle Sales Online is certified on JDK 1.2.2; this is recommended for optimum 
performance. 

The application architecture for Oracle Sales Online is as follows:

Technology Stack
Oracle Forms Designer, version 6.0.8.10.3

Oracle 8 Enterprise Edition Release, version 8.1.6

Oracle Reports Designer, version 6.0.8.8.3 

Oracle WebDB, version 2.2.2.1

Apache version, version 1.3.9

Java Developer Kit Server Side, version 1.1.8

Oracle JSP engine 1.0.0.6 and 1.1.2 (recommended)

Dependencies
Sales Online requires the following related products, components, and their 
dependencies, to be installed and implemented:

■ Oracle CRM Foundation Components (Resource Manager, Task Manager, 
Notes)

■ Oracle Sales

■ Oracle iStore (If you want to use Quoting, please note that Oracle Order 
Capture is a dependency of Oracle iStore.)

Related Products and Components
Oracle Sales Online provides functional integration with the following Oracle 
applications:

■ Oracle ERP applications (HRMS, Inventory, Order Management, Accounts 
Receivable, Trading Community Architecture)

■ Oracle CRM Foundation Components (Interaction History, Territory Manager, 
1-to-1 Fulfillment)

■ Oracle Marketing Online
6 Oracle Sales Online Implementation Guide 



Implementation Steps
■ Oracle Marketing Encyclopedia

■ Oracle Partner Relationship Management

■ Oracle Sales Compensation

■ Oracle Service

■ Oracle TeleSales 

Setting Up Sales Online

Overview
The following sections of this document describe the pre-installation and 
implementation steps necessary to implement Sales Online.

Pre-Installation Steps
These steps must be performed before Sales Online is installed.

Prior to applying the CRM Family Pack, you must install the following standalone 
utilities into your database.

1. Install XML Parser for PL/SQL (plxmlparserV1_0_1.zip)

2. Install XML SQL Utility (Xsul2.zip)

Note: You can find Install XML Parser for PL/SQL and XML SQL Utility in the 
utility directory in the common area of your file system.

Unzip both files and follow the directions in the readme.html file to load them. If 
you need more instructions, you can find them in the CRM Family Pack installation.

3. Check to make sure that a jar directory has been created under ASF_TOP before 
installing the ASF patch. Make sure that the user performing the installation has 
privileges to write to the directory.

Implementation Steps
The table below summarizes the necessary steps to successfully implement Oracle 
Sales Online. Further information detailing the implementation procedures is 
provided in the sections following the table.
Implementing Oracle Sales Online 7



Implementation Steps
Please note, depending upon your implementation of Sales Online, you might see a 
Calendar subtab under the Activity tab. This is an alpha version of this feature. This 
version is not supported for use by production at this time. This prototype version 
of the up-and-coming production version will be supported in a future release of 
Sales Online. To exclude the Calendar subtab from the Activity tab, using a menu 
exclusion. For details about menu exclusion, please refer to the Implementing Oracle 
CRM Foundation guide.

Prerequisites

Completion of installation and implementation steps as outlined in the following 
documents:

■ Oracle System Administrator’s Guide 

■ Supplemental CRM Installation Steps Release 11i 

User creation and assignment of Oracle Sales Administration, Order Management 
Super User, Receivables Manager, and System Administrator responsibilities must 
also be completed. 

Steps

Mandatory Step Number Oracle Sales Online Implementation Steps

❏ Yes ❏ Step 1 Create employee in HR

Reference: Implementing Oracle HRMS

❏ Yes ❏ Step 2 Define users and assign responsibilities. (Switch to System 
Administrator responsibility to perform this step.)

Reference: Oracle Applications System Administrator User’s Guide

❏ Yes ❏ Step 3 In Resource Manager:

a. Import Employees

b. Define Resource Groups

c. Create Resources and Assign Roles

d. Assign Resources to Group

Source: Implementing Oracle CRM Foundation, Resources

❏ Yes ❏ Step 4 Create Locations and Organizations

Source: Implementing Oracle HRMS
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Implementation Steps
❏ Yes ❏ Step 5 Set up Customer

Source: Oracle Accounts Receivable User Guide

❏ Yes ❏ Step 6 Set up Home Page

❏ Yes

(steps 7 h and i 
are optional)

❏ Step 7 Set up Opportunity and Forecasting:

a. Status

b. Win Probability

c. Stages

d. Calendar

e. Define Credit Types (Switch to Order 
Management responsibility for this step)

f. Interest Types

g. Interest Codes

h. Plan Element Mapping

i. Load Inventory Categories

j. Currencies

k. Forecast Category Mapping

l. Create Materialized Views

❏ Optional ❏ Step 8 Set up Quoting

❏ Optional ❏ Step 9 Set up Opportunity Exchange

❏ Yes ❏ Step 10 Set up Security Profiles

❏ Yes ❏ Step 11 Lookups

❏ Yes ❏ Step 12 System Profile Options

❏ Yes ❏ Step 13 Set up Note Types and map to source

Reference: Implementing Oracle CRM Foundation, Notes

❏ Optional ❏ Step 14 Set up Territory Management

Reference: Implementing Oracle CRM Foundation, Territories

❏ Yes ❏ Step 15 Set up Task Manager (types, status, priorities)

Reference: Implementing Oracle CRM Foundation, Task Manager

Mandatory Step Number Oracle Sales Online Implementation Steps
Implementing Oracle Sales Online 9



Step 1: Creating an Employee in Oracle HRMS
Step 1: Creating an Employee in Oracle HRMS
This step must be performed by a user with HRMS Manager responsibility. The user 
must be defined as an employee/user in Oracle HRMS.

Reference:  Managing People Using Oracle HRMS Release 11i, Chapter 1 - Employee 
Management, Special Information Types, Entering and Maintaining a New Person.

Step 2: Defining Users and Assigning Responsibilities
This step must be performed by a user with System Administrator responsibility.

In this step, you will create an Oracle Applications user and associate the user to the 
HRMS employee defined.  Then you will give the user the responsibility of Oracle 

❏ Optional ❏ Step 16 Set up Interaction History

Reference: Implementing Oracle CRM Foundation, Interaction History

❏ Optional ❏ Step 17 Set up  Marketing Encyclopedia

Source: Oracle Marketing Encyclopedia Implementation Guide

❏ Optional ❏ Step 18 Set up Marketing Campaigns

Reference: Implementing Oracle Marketing Online

❏ Optional ❏ Step 19 Set up Fulfillment

Reference: Implementing Oracle CRM Foundation, 1-to-1 Fulfillment

❏ Optional ❏ Step 20 Set up Partners 

Reference: Implementing Oracle Partner Relationship Management

❏ Optional ❏ Step 21 Set up Compensation

Reference: Implementing Oracle Sales Compensation

❏ Yes ❏ Step 22 Run Concurrent Programs

❏ Optional ❏ Step 23 Set up Descriptive Flexfields 

Reference: Oracle Applications Flexfield Guide

❏ Optional ❏ Step 24 Set up Blind Search for LOV

❏ Optional ❏ Step 25 Setting up Import Leads

❏ Optional ❏ Step 26 Set up Sales Online Wireless

Mandatory Step Number Oracle Sales Online Implementation Steps
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Step 3: Creating, Modifying, and Importing Resources
Sales Online User,  Sales Online Manager,  Oracle Sales Administrator, or any 
responsibility that has access to Oracle Sales Online.

Reference: Oracle Applications System Administrator’s Guide, Managing Oracle 
Applications Security, Users Window, Responsibilities Block

Note: You will need the user id when creating resources.

Step 3: Creating, Modifying, and Importing Resources
Follow the general guidelines as outlined in Oracle CRM Foundation Components 
Concepts and Procedures, Release 11i.  Tasks and tips specific to implementation for 
Oracle Sales Online are provided below. 

3a) Importing Resources
1. Under the Oracle Sales Administrator responsibility, choose CRM Foundation 

> Resource Manager >Maintain Resources > Import Resources

The Selection Criteria window opens.

2. "Employee" should be the entry in the Resource Category field.

3. When importing a single employee, choose to find employees by name, 
otherwise use job title, competency or other criteria to find resources.

Note: The system will generate a resource number which you can use to find 
resources in the next section.

Reference: Oracle CRM Foundation Components Concepts and Procedures, Release 11i, 
Using Resource Manager

3b) Defining Resource Groups
1. Under the Oracle Sales Administrator responsibility, choose CRM Foundation 

> Resource Manager >Maintain Resources > Groups

The Define Groups window appears.

2. To find an existing resource group:

a. Click Find on the application toolbar to open the Find Group window.

b. Select a group name from the list of values in the Group Name field and 
click Find. The application populates the Results section with the group 
name search results.
Implementing Oracle Sales Online 11



Step 3: Creating, Modifying, and Importing Resources
c. Select a group name in the Results table and click OK. The application 
populates the Define Groups window with the group information.

3.  To create a new group:

a. Enter a group name in the Group Name field.

b. Enter a brief description of the group in the Group Description field.

c. Enter the effective dates for the group in the Start and End fields.

4. Use the Relations tab to relate Parent Groups.

5. Save your work when finished.

Note: Group usages must be "Sales & TeleSales" or the user will not be able to log 
in. Also, in order to enable the resources to perform partner functions the Group 
usage must also be set to "Sales & TeleSales."

Note: It is easiest to build the hierarchy from the bottom of the hierarchy to the top.

Reference: Oracle CRM Foundation Components Concepts and Procedures, Release 11i, 
Using Resource Manager, Defining Resource Groups.

3c) Creating and Modifying Resources
1. Under the Oracle Sales Administrator responsibility, choose CRM Foundation 

>Resource Manager >Maintain Resources >Resources

The Find Resource window appears.

2. Select Employee (or other resource) from the list of values in the Category field.

3. Select from the list of values in the Transaction Number and Name fields.

4. Click Find.

The Resource Search results window opens

5. Select the desired resource and click Resource Details to open the Resource 
window.

6. Verify that the user name is displayed in the User Name field, if no name is 
displayed, enter the user name.

7. In the Roles tab, assign a Role Type of Sales, Telesales, or Partner Relationship 
Management. Role type must be one of those three or the user will not be able 
to log into Sales Online.

8. Define the role by selecting from the drop down list.
12 Oracle Sales Online Implementation Guide 



Step 3: Creating, Modifying, and Importing Resources
9. Save your work when finished.

Sales managers need to have roles called Sales Manager. Seeded roles include Sales 
Representative and Sales Manager. Additional Sales roles can be created but the 
seeded roles are tied to specific Oracle Online Sales functionality. Use of the seeded 
roles is recommended.

Note: A group can have only one manager. Having multiple managers in a group 
will cause problems with forecasting rollups.

If a manager has his or her own opportunities, then he or she should be both a 
manager and a member of the group. This is accomplished by:

1. Giving the manager resource both the Sales Manager and the Sales 
Representative roles.

Reference: Oracle CRM Foundation Components Concepts and Procedures, Release 11i, 
Using Resource Manager

3d) Assign Resources to Groups
1. From the Resources window, in the Groups tab, assign the resource to a group.

2. Define your Group by selecting from the list of values.

3. Define your Group Member Roles by selecting from the list of values.

4. Save your work when finished.

Note: A resource can be in multiple groups. This is supported in Oracle Sales 
Online’s Opportunity and Forecasting module.

Note: A group can have only one manager. Having multiple managers in a group 
will cause problems with forecasting rollups.

If a manager has his or her own opportunities, then he or she should be both a 
manager and a member of the group. This is accomplished by:

1. Giving the manager resource both the Sales Manager and the Sales 
Representative roles.

2. Adding the manager to the group once and assigning both Sales Manager 
and Sales Representative roles for that group.

Note: When moving a sales person from one group to another, do not remove them 
from their original group. Instead, click the Move button and add them to the new 
group. This will automatically end date their previous group membership.
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Reference: Oracle CRM Foundation Components Concepts and Procedures, Release 11i, 
Using Resource Manager

Step 4: Creating Locations and Organizations
This step is part of multi-org setup. Employees are assigned to organizations and 
users are tied to responsibilities that are specific to their organization.

Reference: Implementing Oracle HRMS (Implementation Steps, Work Structures)

Step 5: Setting Up Customer
This is an overview of the detailed directions you will find in the referenced 
document, Oracle Accounts Receivable User Guide and Oracle Accounts Receivables 
Implementation Guide. In this step, you define states, provinces, and counties in this 
step. Before you begin, you will need to switch responsibilities to Receivables 
Manager.

Reference: Oracle Accounts Receivables User Guide and Oracle Accounts Receivables 
Implementation Guide

5a) Define Sales Tax Location Flexfield
1. Switch responsibilities to Receivables Manager.

2. Go to Set Up > Financials > Flexfields > Key > Segments.

3. To set up the Tax Location Flexfields:

■ Query the existing "Sales Tax Location Flexfield" in the "Oracle Receivables" 
application.

■ Create a new structure in the flexfield for each country, province, and state.

4. Once you have completed the previous step, do the following:

■ Freeze the Flexfield segments for the Structure you have set up.

■ Compile the flexfield by clicking the Compile button in the main Key 
Flexfield Segments window.

5. After you have compiled the flexfields, reference the new structure in the 
Receivables System Options set up.
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5b) Set Up Receivables System Options
In this step you will set up the Receivables System options. Before you begin, if you 
have not already done so, switch responsibilities to Receivables Manager.

Reference: Oracle Accounts Receivables User Guide and Oracle Accounts Receivables 
Implementation Guide

1. Go to Set Up > System > System Options.

2. Under "Tax" set the "Location Flexfield Structure" to the new structure set up in 
step 5a. Save this change and five concurrent jobs will be submitted to generate 
the Tax Location Structure. The Tax Locations screen may not be accessed, to 
enter the actual State or Province values, before these concurrent jobs have 
completed.

If there are any incompletely or inaccurately defined Tax Location Flexfield 
Structures in the Key Segments screen, then all five concurrent jobs will usually 
fail.

Note: If the first four jobs complete and only the final job fails, this will not 
impact further use of the location structure in CRM.

5c) Set Up Tax Locations
In this step you will set up the tax locations.

Reference: Oracle Accounts Receivables User Guide and Oracle Accounts Receivables 
Implementation Guide

1. Go to Set Up > Tax > Locations.

Step 6: Setting Up Home Page
In order to personalize your home page, you must run the following concurrent 
programs.

For more information about running concurrent programs, see Step 22.

1. Refresh AS_PERIOD_DAYS table

2. Refresh of AS_SALES_CREDITS_DENORM (Complete)

3. Initial Build of Opportunity and Lead Bins

This program is used for the Opportunity home page bins. This program 
must be run initially before users can set up Opportunity bins. This 
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program loads the materialized view with sales credit information. No 
parameters are needed.

Note: You must run this program every time the as_sales_credit_denorm is 
rebuilt or when values such as sales stages or statuses are changed.

4. Initial Load for Leads Reports

5. Initial Load for Opportunities Reports

To refresh home page bins and reports, run the following concurrent programs at 
regular intervals:

1. Refresh of Opportunity Bins Data

This program should be scheduled to run periodically to refresh the 
materialized view for the Opportunity bins. 

Note: Users will not see opportunities in the bins that were created after the 
last refresh of the materialized view.

2. Refresh of Lead Bins Data

This program should be scheduled to run periodically to refresh the 
materialized view for the Leads bin. 

Note: Users will not see leads in the bins that were created after the last 
refresh of the materialized view.

3. Refresh of Leads Reports

Note: You will need to run this program after applying any OSO patch.

4. Refresh for Opportunities Reports

5. Refresh of AS_SALES_CREDITS_DENORM (Incremental)

6. Incremental Refresh of AS_MC_SALES_CREDITS_DEN table (From, To)

For more information on setting up home page marketing reference material, 
please refer to Oracle Marketing Encyclopedia Concepts and Procedures Guide, 
"Integrating with OneSource" under the "Implementing Oracle Marketing 
Encyclopedia" section.

Step 7: Setting Up Opportunity and Forecasting 
Sales people can categorize opportunity purchases using three variables.
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■ Sales Status is a user-defined and modifiable classification. Statuses can be 
defined as open or closed. If the status is closed, it can be further defined as 
won or lost. Status can also be flagged as forecastable.

■ Win Probabilities: the percentage chance that a particular purchase will be won. 
This is a user-defined and modifiable classification which defaults to ten win 
probabilities in ten percentage increments, from 0 to 100.

■ Sales Stages is a user defined and modifiable classification starting with the 
initial contact with a customer through to the sale.

System Profiles for Categorizing Opportunities and Forecasting
Opportunity and Forecasting classifications are governed by the following profiles:

Opportunity Profiles
■ ASO: Product Organization: Org id used in displayed inventory items 

(mandatory).

■ OSO: Enable Lead Share: Display Lead Share button

■ OS: Enable Real Time Opportunity and Customer Assignment

■ OSO: Enable Quote: If set to YES, displays the Create Quote button

■ OS: Inventory Category Integration: Flag to populate Inventory categories in 
Oracle Sales

■ OS: Compensation Sales Credit Type: Compensation Sales Credit Type

■ OS: Customer Address Required for Opportunity and Sales Lead: Customer 
address required for opportunity.

■ OS: Default Close Date Days: Default Opportunity Close Date days (Value + 
Current Date = Opportunity Close Date)

■ OS: Default Opportunity Sales Stage: Default Sales Stage

■ OS: Default Opportunity Status: Default Opportunity Status

■ OS: Default Opportunity Win Probability: Default Opportunity Win 
Probability

■ OS: Default Sales Channel: Default Sales Channel

■ OS: Generate Opportunity System Notes: Determines whether or not notes are 
generated when parts of the opportunity change.
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■ OS: Maximum Roll Days for Converting Amount: Maximum Roll Days for 
Converting Amount if no conversion rate for a day.

■ OSO: Opportunity Probability Link: Determines whether a warning or an 
error is given if the win probability amount does not fall within the sales stage 
probabilities. The warning is turned on by default.

■ OS: Opportunity Sales Credit Enforce Sales Team Definition: If set to Yes,  a 
user cannot remove a person from an opportunity sales team if that person is 
receiving sales credits for that opportunity.

■ OS: Sales Methodology: Default sales methodology

■ OS: Sales Team Creator Keep Flag: Default keep flag for sales team creator.

■ OS: Forecast Sales Credit Type: Forecast Credit Type for Opportunity Sales 
Credits (mandatory)

■ OS: Daily Conversion Type: Currency conversion type used for daily 
conversion rates.

■ OS: Date Mapping Type: Indicates whether the first or last date of the period is 
used for calculating pseudo period rates.

■ OS: Allow Updating Frozen Opportunities: When set to yes, users can update 
frozen opportunities.

■ OSO: Enable Product Category in Opportunity Advanced Search: The profile 
is used in Opportunity Advanced Search. If set to Yes, the product category 
multi-select list is displayed and you can perform a search by product category.

■ OS: Opportunity Sales Team Default Role Type: The role set by this profile is 
used as a default when creating a sales team entry for opportunity.

Forecasting Profiles
■ OSO: Default Forecast Currency: Default currency used for forecasting.

■ OSO: Default Forecast Period Type: Default period used for forecasting.

■ OSO: Default Forecast Worksheet Lines: Choose to default worksheet lines to 
zero or pipeline.

■ OSO: Display Subordinate Current Pipeline: Choose to display subordinate 
current pipeline on the Manager’s forecast page.

■ OSO: Display Opportunity Worksheet Grand Totals: Choose to display 
worksheet grand totals.
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■ OSO: Forecast Calendar Month: Choose the forecast calendar month.

■ OS: Forecast Calendar: The name of the calendar being used to manage 
forecasts.

■ OS: Use Forecast Materialized View: If set to yes, materialized views will be 
used to display data on the forecast pages.

■ OSO: Forecast Autosubmit Worksheets: Used to set the default worksheet(s) to 
be submitted when submitting forecasts.

■ OSO: Forecast Max Generate Months: The maximum number of months that 
the rep can submit forecast for on the Generate Forecast page.

7a) Opportunity Status
There is a set of predefined statuses included with the application. You may choose 
not to use the predefined set and create customized statuses of your own. Or, you 
can use both the predefined set and additional customized statuses.

The following statuses are predefined:

■ Active

■ Inactive

■ Lost

■ Won

■ Forecast

■ No Opportunity

■ Dealer

■ Expired

■ Preliminary

■ Upside

■ New Opportunity

Use the following procedure to define Opportunity Status.

Steps
1. Under the Sales Administrator responsibility, choose Oracle Sales Set up > 

Opportunity > Status
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2. Enter the status code meaning and description for the status. The meaning is 
displayed on the user interface.

3. The Open check box is used to signify whether the opportunity is open or 
closed. If the check box is selected, it means that the opportunity is open. 
Conversely, if the check box is not selected, it means that the opportunity is 
closed and therefore requires you to enter a close reason.

4. The defined status can be used for Opportunity, Sales Lead, or both, by 
selecting the appropriate check box in the "Used For" region.

5. The Win Loss Indicator region indicates whether the deal has been won or lost. 
If the open flag is unchecked, then the choices are won or lost.

6. Select the Used in Forecast check box in order to be able to include the 
opportunity in the forecast.

7. Select a usage level (Partner Relationship Management Only, Oracle Sales Only, 
or All) to determine whether the status will be displayed on the Partner 
Relationship Management screen, the Oracle Sales screen, or both. The default 
entry is All.

8. Select the Enabled check box to activate the opportunity status.

9. Save your work.

7b) Modifying Win Probabilities
Win probabilities are used to calculate weighted pipeline amounts (opportunity 
amount multiplied by win probability).

There is a set of predefined Win Probabilities included with the application. You 
may choose not to use the predefined set and create customized win probabilities of 
your own. Or, you can use both the predefined set and additional customized Win 
Probabilities.

Use the following procedure to define or modify Win Probabilities.

Steps
1. Choose Oracle Sales Setup > Opportunities > Win Probabilities under the 

Oracle Sales Administrator responsibility.

The Define Win Probabilities Window appears.

2. To enter a new probability:

a. Click in a Win Probability field in a new row.
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b. Enter a Value between 0 and 100.

3. Enter or change the information in the Meaning field.

4. Enter a start date in the From field.  An entry in this field is mandatory.

5. Optionally, enter an end date in the To field. If an end date is entered, the Win 
Probability is disabled after that date.

6. Select a usage level (Partner Relationship Management Only, Oracle Sales Only, 
or All) to determine whether the Win probability will be displayed on the 
Partner Relationship Management screen, the Oracle Sales screen, or both. The 
default entry is All.

7. Select the Enabled check box to enable the Win Probability. If the Enabled box is 
not selected, the Win Probability will not appear in the user’s interface.

8. Save your work.

7c) Defining or Modifying Sales Stages
There is a set of predefined Sales Stages included with the application. You may 
choose not to use the predefined set and create customized Sales Stages of your 
own. Or, you can use both the predefined set and additional customized Sales 
Stages.

Use the following procedure to define or modify Sales Stages.

Steps
1. Choose Oracle Sales Setup > Opportunities > Sales Stages under the Oracle 

Sales Administrator responsibility.

The Sales Stages Window appears.

2. To enter a new Sales Stage:

a. Click in a Name field in a new row.

b. Enter a name to appear in the LOV.

c. Enter a description

d. Enter a minimum and a maximum win probability value for this stage in 
the Min and Max fields.

If the profile "OS: Opportunity Probability link is set to "warning" or "error," 
the system will accept values outside range but give a warning message.
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e. Enter a start date in the From field.  An entry in this field is mandatory.

f. Optionally, enter an end date in the To field. If an end date is entered, the 
Sales Stage will be disabled after that date.

3. Select a usage level (Partner Relationship Management Only, Oracle Sales Only, 
or All) to determine whether the Sales Stage will be displayed on the Partner 
Relationship Management screen, the Oracle Sales screen, or both. The default 
entry is All. 

4. Select the Enabled check box to enable the Sales Stage. If the Enabled box is not 
selected, the Sales Stage will not be enabled.

5. Save your work.

7d) Calendar
You must set up a calendar for forecasting. Define a calendar that represents your 
organizations fiscal cycles.

Steps
1. You must first define period types (e.g., month, quarter, year). Choose Oracle 

Sales Set up > Opportunity > Calendar > Types.

2. Define your accounting calendar. Choose Oracle Sales Set up > Opportunity > 
Calendar > Accounting.

Refer to the General Ledger Users Guide (Set up, Planning and Installation: Period Types 
and Calendars) for more information.

7e) Defining Credit Types (Order Management)
Forecast and other credit types need to be set up for use in Oracle Sales Online. Use 
the following procedure to define credit types.

Steps
1. Switch responsibility to Order Management Superuser.

2. Choose Set up > Sales > Credit Types.

The Sales Credit Type window appears.

3. Enter the user defined Forecast Credit Type name and description in the 
appropriate fields.
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4. Select the Quota check box if the forecast credit type applies to revenue quota 
sales credit that you assign to salespeople. This means if it is forecastable.

5. Select the Enabled check box to activate the forecast credit type.

6. Enter values in profile options.

7. Switch responsibility to System Administrator, and choose Profiles > System 
Admin.

8. Query "OS: Forecast Sales Credit Type" and enter the value that you want to use 
for Forecast Sales Credits. The value must have the quota check box selected.

9. Query "OS: Compensation Sales Credit Type" to set compensation sales credits. 
The quota check box should be unchecked.

10. Save your work.

Defining Interest Types and Codes
Interest types and codes allow you to classify your contacts, opportunities, expected 
purchases (i.e., purchase lines), and the current environment.

Interest types and codes can represent classes of products your company produces 
or provide a way to classify opportunities according to the categories your 
organization cares about. Examples include geographic location, business size, 
industry, or economic sector. Interest types and codes can also be used for assigning 
territories and for forecasting.

7f) Setting Up Interest Types
Interest Types can be used to classify your customers (organizations and people), 
opportunities, and purchases in a number of ways. An interest type can represent 
any classification of products.

The Interest Type classification has three layers:

- Interest Type

      - Primary Interest Type 

            - Secondary Interest Code

Use the following procedure to define Interest Types.
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Steps
1. Choose Oracle Sales Setup > Sales Categories > Interest Codes and Types 

>Types under the Oracle Sales Administrator responsibility.

The Interest Types Window appears.

2. Select the first blank Type field and enter the name of the interest type. 

3. Optionally, enter a description in the Description Field. 

4. Select all applicable check boxes to indicate where the classification is to be used 
(Account Classification, Contact Interest, Opportunity Classification, Expected 
Purchase). 

Note: Sales Online does not use interest types to classify customers. Sales 
Online uses the Trading Community Architecture (TCA) Customer 
Classification lookup. See the Lookup section of this document.

5. Select the Enabled check box to enable the interest type. If the Enabled check 
box is not selected, the interest type will not appear in the user’s interface.

6. Save your work.

7g) Setting Up Interest Codes
For every interest type you can have two levels of interest codes: primary and 
secondary.

If you are defining interest types to classify your company’s products, use the 
primary code to identify large groupings of products. For example, for a computer 
company you might use the primary codes computer, peripherals, connectors, 
printers, and so on. You might then use the secondary codes for product families:  
desktops, laptops, modems, inkjet printers.

Use the following procedure to create Interest Codes.

Steps
1. Choose Oracle Sales Setup > Sales Categories > Interest Codes and Types 

>Codes under the Oracle Sales Administrator responsibility. 

The Interest Codes window appears.

2. Enter the Interest Type you wish to set up codes from the List of Values (LOV). 
The group of check boxes display where this Interest Type can be used. They are 
read only and cannot be modified. 
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3. Click Find to see what codes, if any, have been set up for this Interest Type.  The 
Primary and Secondary Code regions will display the results of the search.

4. In the Primary Codes region, enter the different values desired for the Interest 
Type. If you are also setting up Secondary Codes, the values entered here will 
be variables with Secondary Codes as their values.

5. If you are setting up Secondary Codes, click in the Code field of the appropriate 
Primary Code.

6. In the Secondary Codes region, select a blank line and enter a Code and Code 
Description. If no blank line is available, click the New Record button on the 
toolbar to create one.

7. Save your work.

7h) Plan Element Mapping
In order for sales personnel to be able to estimate their commissions based on their 
submitted product category worksheet forecasts, interest types and codes must be 
mapped to Plan Elements in Oracle Sales Compensation.

One Plan Element can be mapped to one or more interest type/primary interest 
code/secondary interest code.

Plan element mapping is required for using Income Planner.

Steps
1. Navigate to Opportunities > Sales Categories > Interest Codes and Types 

>Plan Element Mapping

2. From the first column, select the plan element you want to map.

3. From the second column, choose the mapping type.

■ Map quota to primary interest code - if you want to map the plan element 
to a primary code.

■ Map quota to secondary interest code - if you want to map the plan element 
to a secondary code.

■ Map quota to interests type - if you want to map the plan element to an 
interest type.

4. Depending on the value you have chosen in step 3 above, continue by choosing 
combinations of interest types and codes.
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5. Save your work. 

7i) Loading Inventory Categories
Inventory Categories are required when using Inventory and other ERP modules.

To implement this feature, the administrator must do the following steps:

Steps
1. Define interest types and set expected purchase flag to "Y" for those interest 

types for which you want to load inventory. 

2. Profile Value Set up:

■ Using the Profiles form, set the OS: Inventory Category Integration profile 
value to Yes.

3. Run the concurrent program:

■ Load Interest Types and Codes to Inventory Categories

This program creates the Inventory Categories.

■ Using the Submit Requests form in Concurrent Requests menu, run the 
concurrent program.

4. Inventory Category and Item Mapping

■ Map each inventory item to an inventory category under the Oracle Sales 
and Marketing Category Set.

This must be done manually by using Oracle Inventory screens. For details please 
refer to Oracle Inventory Concepts and Procedures Guide.

Note: An item can be mapped to only one Category in a given category set. This is a 
restriction from Oracle Inventory.

7j) Working with Multiple Currencies
The multiple currency capabilities of Oracle Sales Online allow your organization to 
enter sales opportunities and forecasts in different currencies. Oracle Sales Online 
automatically converts them to a single currency of your choice when summing up 
forecasts and opportunity purchases in the pipeline.

Oracle Sales Online calculates currency conversion for individual opportunity 
purchases based on the daily rate on the date a sales person predicts an opportunity 
is going to close (the close date). If a conversion rate is missing, then the program 
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looks back in time to find a conversion rate. How far back is determined by setting 
the value of the profile OS: Maximum Roll Days for Converting Amount. If no rate 
is found within this period, then Oracle Sales Online will display asterisks with a 
message that no rates were found.

The currency conversion type for opportunities is set by the profile OS: Daily 
Conversion Type.

If you are using multi-currency features of Oracle General Ledger (GL) in your 
company, then you can use the daily conversion rates being entered there. 
Otherwise, you must enter the conversion rates for each day using the Daily Rates 
Window.

Prerequisite Profile Option Setups for Global Forecasting
■ OSO: Default Forecast Currency

Oracle Sales estimates currency conversion rates for the forecast periods based on 
one daily conversion rate. Because the rate for a whole period is based on one day’s 
rate, these conversion rates are called "pseudo" period rates. You can choose to use 
the daily rate at the beginning or the end of a period. For example, if you are setting 
up the conversion rates for the month of January 2001, you can use either the daily 
rate on January 1 or January 31 as the rate for the whole month.

Forecasting uses currency conversions in two places: to calculate the total forecast 
amounts at the bottom of the forecast window and to sum all forecasts from the 
sales person to obtain group forecasts. In both cases it uses the pseudo period rates 
for the conversion.

Forecasting calculates currency conversion based upon pseudo period rates only.

If you are a manager or administrator, on the forecast main page the currency is 
converted all the time. But on the opportunity worksheet and the product category 
worksheet, currency amounts are not converted when you drill down to a 
subordinate’s forecast.

If you have submitted a worksheet, you cannot change the currency in the 
forecasting profile for that period.

Entering Daily Conversion Rates
If your company does not set daily currency conversion rates in Oracle General 
Ledger and you are planing to use multi-currency forecasts, you will need to enter 
conversion rates on a daily basis using the Daily Rates Window. Follow the 
procedure described below.
Implementing Oracle Sales Online 27



Step 7: Setting Up Opportunity and Forecasting
Steps 
1. Choose Oracle Sales Setup > Multi-currencies > GL Daily Rates under the 

Oracle Sales Administrator responsibility.

The Daily Rates window appears.

2. Click in the From field and enter the currency you are converting from the LOV.

3. If your currency does not appear in the adjacent To field, enter it from the LOV.

4. In the Type field, enter the conversion rate type from the LOV.

5. Enter the daily conversion rate in either of the currency conversion fields. The 
second rate will be calculated and entered automatically.

6. Repeat steps 2 through 5 for any other currencies.

7. Save your work.

Entering Currency Conversion Dates for Periods (Pseudo Period Rates)
Follow the procedure below to be able to forecast sales in multiple currencies.

Steps
1. Set the profile option OS: Forecast Calendar to the calendar your organization is 

using.

2. Follow the steps for the procedure "Setting Up Conversion Types for Period 
Types" below to enter the types of conversion rates you will use for each period 
type such as fiscal year, month, or quarter for the calendar you selected in step 
1.

3. Set system profile OS: Date Mapping Type by choosing whether you want to 
use the daily rate from the start or end date of a period for currency conversion.

4. Follow the steps for the procedure "Defining Conversion Rates for Periods" 
below to search to see if the conversion rates have been entered for your 
periods. Enter any missing conversion rates.

Setting Up Conversion Types for Period Types

Steps
1. Choose Oracle Sales Setup > Multi-currencies > Type Mapping under the 

Oracle Sales Administrator responsibility.

The Calendar window appears.
28 Oracle Sales Online Implementation Guide 



Step 7: Setting Up Opportunity and Forecasting
2. Enter the calendar for which you are setting conversion rates from the LOV. 
Make sure that the calendar you are using is the forecast calendar.

3. Click Find. If any period types have conversion rates associated with them, the 
Types Mappings region will be populated.

4. In Period Type, use the LOV to enter a period type for which you wish to set up 
conversion rates.

5. In Conversion Type, use the LOV to enter the currency conversion type you 
want to use.

6. Check the Updatable and Deletable check boxes if you want to allow the 
currency conversion rates to be changed in the Pseudo Period Rates Window 
(See Defining Conversion Rates for Periods below).

7. Repeat steps 4 through 6 for all period types in this calendar.

8. If you want these rates to be updatable and editable by the user, check the 
appropriate check box.

9. Save your work.

Defining Conversion Rates for Periods

Steps
1. Choose Oracle Sales Setup > Multi-currencies > Pseudo Period Rates  under 

the Oracle Sales Administrator responsibility.

The Pseudo Period Rates window appears.

2. Enter the calendar your organization is using from the LOV in the Calendar 
field. This should be the same calendar set up in OS: Forecast Calendar.

3. Select the Start Date or End Date radio button. Your selection must be the same 
as the one you made when you set up the OS: Date Mapping Type system 
profile.

4. If you want to modify information only about a single period, enter the period 
name in the Period field. If this field is left blank, the search will display all 
periods that have daily rates entered for them.

5. Click Find.

6. The Period Rates region will display all periods that have the rate values 
available.
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7. If any periods are missing, you will have to add them manually:

a. Click in an empty Period field in the Period Rates Region (or create one by 
clicking the New Record button in the toolbar) and use the LOV to enter a 
period.

b. Using the LOV, enter the currency you wish to convert in the From field.

c. Using the LOV, enter the currency you wish to convert to in the To field.

d. Enter the rate in the Rate field.

e. Repeat steps a through d until you have added all the periods you wish to 
be able to forecast. 

8. If you wish to modify any displayed rates, you can do so by making a change in 
the Rates field.

Note: You cannot modify the rate field if the Updatable check box is not 
checked. This check box is set in the Period Type and Daily Conversion Type 
Mappings window.

9. Save your work.

Reporting Currency Mapping
All opportunity and forecast currency conversions are based upon the reporting 
currency setups.

Steps
1. Choose Oracle Sales Setup > Multi-Currencies > Reporting Currency under 

the Oracle Sales Administrator responsibility.

The Reporting Currency window opens.

2. Enter transaction currency in the Transaction Currency field.

3. Enter reporting currency in the Reporting Currency field.

4. Enter the date the mapping is active in the Start Date field.

5. Optionally, enter the date the mapping ends in the End Date field.

6. Save your work.
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7k) Forecast Category Mapping
Forecast categories are used to categorize a group of product categories for the 
purpose of forecasting. Currently, the creation of additional forecast categories is 
not allowed.

Use the following procedure to set up Forecast Categories.

Steps
1. Choose Oracle Sales Setup > Forecast >Forecast Category Setup > Forecast 

Category Mapping under the Oracle Sales Administrator responsibility.

The Forecasts Sales Categories window appears.

2. Enter the Forecast Category Name from the LOV.

3. Enter the Interest Type from the LOV.

4. Enter the Start Date.

5. Enter an End Date. 

Note: You can forecast only when the forecast dates fall within the forecast category 
dates.

7l) Create Materialized Views
The materialized view uses a periodically refreshed aggregation table that reduces 
query execution time in generating Current Pipeline Values on this page. Please 
make note, this feature does not run in real-time. According to business 
requirements, the table is refreshed periodically based on a pre-determined 
schedule. In the Sales Online application, a line in blue lettering, below the forecast 
profile option, shows the exact time stamp. Please see the Sales Online Concepts and 
Procedures Guide for additional information.

Steps
Run the following concurrent programs to create materialized views for forecasting.

■ Initial Build of Forecast Summary Table: Builds the materialized view to view 
forecast summary page

■ Refresh of Forecast Summary Tables

■ Refresh of AS_SALES_CREDITS_DENORM

■ Build Materialized View for Forecast Main Page: Populated the data from 
as_sales_credits_denorm
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The first time you create materialized views, you must run both the Initial Forecast 
Summary Table and Build Materialized View for Forecast Main Page concurrent 
programs. To get updated pipeline values, you must run the Refresh Forecast 
Summary Table concurrent program.

Step 8: Setting up Quoting
Please see the Oracle HTML Quoting Implementation Guide for detailed instructions 
and information. 

You must set the profile OSO: Enable Quote in order to see the "Create Quote" 
button.

Please note, you can skip the following steps in the Oracle HTML Quoting 
Implementation Guide if you have already performed them in Sales Online:

■ Step 5: Process Flow for Required Sales Representative Steps

■ Step 6: Defining a Sales Representative Responsibility

■ Step 7: Setting Up Sales Representatives

Step 9: Setting Up Opportunity Exchange 
Opportunity exchange allows two partners to work simultaneously on the same 
opportunity in order to stimulate collaborative selling.

Setting up the opportunity exchange requires two different setups.

1. LETS (Opportunity Exchange Transaction Server) setup.

This includes the steps to setup a partner on the LETS to enable sharing of 
opportunities. Only when the partner is set up on the server can the exchange of 
information take place.

2. Vendor/Partner Setup.

This includes the setup needed to actually carry out the exchange of information 
between partners.

Here are the steps to set up the LETS Server:

1. Login to the LETS server.

2. Choose the Create Partner tab.

3. Enter the company name.
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4. Enter the company code (this can be the company stock ticker or the company 
short name).

5. Submit changes.

6. The confirm partner information appears.

Note: You will need the partner ID that is generated in order to exchange 
opportunities.

System Profiles for Opportunity Exchange
■ OSO: Enable Lead Share: The profile option to enable opportunity sharing 

throughout the system

■ OSO: Lead Share Application ID: Application ID

■ OSO: Lead Share Company Code: The company code which you registered on 
the LETS server

■ OSO: Lead Share Responsibility ID: The default responsibility of the sales 
person who is assigned the opportunities

■ OSO: Lead Share Host Name: The host name of the LETS server

■ OSO: Lead Share Port Number: The port number of the LETS server

■ OSO: Lead Share Proxy Host: The proxy host name of the LETS server

■ OSO: Lead Share Proxy Port: The port number of the proxy host name of the 
LETS server

■ OSO: Lead Share Partner ID: Partner ID generated from the LETS server

■ OSO: Lead Share Mail From: In case of error, in the data send and fetch 
between partners, an email is sent from this user.

■ OSO: Lead Share Mail To: In case of error in the data send and fetch between 
partners, an email is sent to this user.

■ OSO: Lead Share Mail CC: In case of error in the data send and fetch between 
partners, an email is carbon copied to this user.

■ OSO: Lead Share Send Flag: Y/N send email when an API error occurs during 
send or fetch data between partners. Default is N.
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Step 10: Setting Up Security Profiles
Access privileges to customer and opportunity information are based on a 
combination of the following profile options:

■ OS: Customer Access Privilege

■ OS: Opportunity Access Privilege

■  OS: Manager Update Access 

■ OS: Sales Admin Update Access

 Security Profiles

Security Profile Description

OS: Customer Access Privilege

OS: Opportunity Access Privilege

"F" (Full): User can view and update all customers and opportunities in 
the user’s organization. Generally, this access is given to super users 
only.

"O" (Full by Organization): This applies to opportunity only. The user can 
view and update all opportunities within their sales team. However, 
they are allowed to view and update data within their HR organization 
only.

"P" (Prospecting): User can view all customers and opportunities. 
Users can update only customers and opportunities within their sales 
team. Users can create only opportunities for customers for which they 
are on the sales team.

"T" (Sales Team Access): User can view only those customers within 
their sales team. Within Sales Online, under the Sales Team link, there is 
a check box called "Full Access". Selecting this check box determines 
whether the sales team member has full access (is able to update 
information) or not for this record. If a user does not have full access, 
the record is view only. The user will see a lock icon next to a record for 
which he/she does not have access.

Party relationship (contact) access is based on a combination of customer and opportunity access. Tasks, 
Notes, Interactions, and Attachments access are based on either customer or opportunity access. For example, 
if you have access to the opportunity, you also have access to the notes and attachments for that opportunity.

OS: Manager Update Access The Manager (as defined in JTF Resources) has access to the records 
that their subordinates can access.

"U": User can always update subordinate’s data.

"I": User inherits subordinate’s access privileges.

The Manager/Admin can update certain customer and opportunities if 
any of their subordinates can update those customers or opportunities.

"R": User can only view subordinate’s data.
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The seeded role "Account Manager", provides special access privileges to the user. 
While an Account Manager on a customer sales team has access to all of the 
opportunities for this customer, a regular user would only have access to the 
opportunities for their own sales team.

The following table describes the customer access privileges.

Customer Access Privileges

OS: Sales Admin Update Access The Administrator (as defined in JTF Resources) has access to the 
records that their group manager can access.

"U": User can always update manager data.

"I": User inherits manager access privileges.

The Manager/Admin can update certain customer and opportunities if 
any of their subordinates can update those customers or opportunities.

"R": User can only view subordinate’s data.

Access Type View Access Create Access Update Access

Full All customers Managers/Reps can create 
customers.

Those with admin role 
cannot create customers.

All customers

Prospecting All customers Managers/Reps can create 
customers.

Those with admin role 
cannot create customers.

The team members can update customer 
information for which they are on the 
sales team.

If update access profile equals "U", the 
user can update subordinates customers.

If update access profile equals "I", then 
the user can update certain customers 
(customers that their employees can 
update).

Sales Team Only customers 
for which the sales 
rep is on the sales 
team.

Managers/Reps can create 
customers.

Those with admin role 
cannot create customers.

Only customers for which the sales rep is 
on the sales team.

Security Profile Description
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The following table describes the opportunity access privileges.

Opportunity Access Privileges

Sales Team 
(Managerial 
Access)

All customers that 
subordinates have 
access to, plus any 
other customers 
based on user’s 
individual access.

All customers If update access profile equals "U", the 
manager can update their subordinates 
customers.

If update access profile is "I", the 
manager can update certain customers 
(customers that their employees can 
update).

Sales Team 
(Administrator 
Access)

All customers that 
administrators, 
employees, and 
managers have 
access to.

None If update access profile is "U", the admin 
can update subordinates customers.

If update access profile is "I", the admin 
can update certain customers (customers 
that their employees can update).

Access Type View Access Create Access Update Access

Full by 
Organization

All opportunities 
for certain 
operating units.

The opportunities 
for which the sales 
rep is on the sales 
team.

All opportunities for 
certain customers.

The user, with admin 
role, cannot create 
opportunities.

All opportunities for certain operating units.

The opportunities for which the sales rep is 
on the sales team with full access.

Full All opportunities All opportunities. All opportunities.

Prospecting All opportunities Same as above. The sales rep with full access can update all 
information for opportunities for which they 
are on the opportunity sales teams.

If update access profile equals "U", the user 
can update subordinates opportunities.

If update access profile equals "I", the user 
can update opportunities that their 
subordinates can update.
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There are four types of Lookup Codes used in the Oracle Sales Online application:

■ Oracle Sales-specific Lookup Codes, which are specific to the Oracle Sales 
product family 

■ Oracle Accounts Receivable Lookup Codes, a subset of AR lookups pertaining 
to Oracle Sales. 

Sales Team (Full 
Access)

Only 
opportunities for 
which the sales rep 
is on the sales 
team

Account manager 
can view 
opportunities for 
their subordinates.

Same as above. Only opportunities of customers for which 
the sales rep is on the sales team.

Sales Team (not 
Full Access)

Same as above. Same as above. Based on individual access.

Sales Team 
(Managerial 
Access)

All opportunities 
that subordinates 
have access to, 
plus any others 
based on 
individual access.

Account manager 
can see all 
opportunities for 
customer they 
manage.

Same as above. If update access profile equals "U", the user 
can update their subordinates opportunities.

If update access profile equals "I", the user 
can update opportunities that their 
subordinates can update.

Sales Team 
(Administrator 
Access)

All opportunities 
that 
administrators, 
employees, and 
managers can 
access.

Account manager 
can see all 
opportunities for 
customers they 
manage.

Same as above. If update access profile equals "U", the user 
can update subordinates opportunities.

If update access profile equals "I", the user 
can update opportunities that their 
subordinates can update.
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■ Oracle Order Management Lookup Codes, which are specific to the Oracle Sales 
product family.

■ Oracle CRM Foundation Lookup Codes, refer to Oracle CRM Foundation 
Components Implementation Guide.

Viewing Oracle Sales Lookup Code Values
Follow this procedure to view Oracle Sales Lookup Code values.

Steps
1. Choose Oracle Sales Setup > Lookup Codes > Sales under the Sales 

Administrator responsibility.

The Oracle Sales Lookup window appears.

2.  Choose View > Query by Example > Enter from the toolbar menu

3. Enter "%" in the Type field.

4. From the Query menu, select Run.

5. Place your cursor in the Type field. You can page through the Lookups using 
the down arrow key to go forward and the up arrow key to go back.

Note: Alternatively, press F11, then while pressing F11 press the Control key to view 
the lookup code values.

Modifying Lookup Code Values
There are three access levels for Lookups:

■ User

■ Extensible

■ System

The Lookups with the User access level are modifiable, meaning that modifications 
can be made to the seeded lookup values or new lookup values can be added. 

Extensible access level Lookups can only be modified by adding new lookup code 
into that lookup type;  any seeded lookup code cannot be modified.

System access level Lookups are not modifiable.

The access level for each lookup type is displayed in the upper right area of the 
Sales Lookup window.
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Follow the procedure below to make changes to a modifiable Lookup.

Steps
Navigate to the Lookup you want to modify.

1. To modify a particular default value, you can edit the field directly.

2. To enter new values, click in a blank line and make your entry. If no blank lines 
are available, select New Record from the Edit menu.

3. Click Save on the toolbar when you are finished modifying the Lookup.

Lookup Code Tables
The following three tables list the Oracle Sales-specific, Oracle Accounts Receivable, 
and Oracle Order Management Lookup Codes, along with their descriptions, access 
level, and seeded values.

 Oracle Sales-Specific Lookup Code Values

Sales Lookup Description
Access 
Level Seeded Values & Meaning

ACCESS_PRIVILEGE Access privilege for 
employee

S F  (Full unrestricted access)

P  (Prospecting Access)

T  (Sales Team Access)

ASTATA_RUN_MODE Run mode for Territory 
Assignment concurrent 
program

S New (Run program in new mode)

Restart  (Run program after new 
mode aborted)

Total (Run program in total mode to 
refresh all access records)

AUTO_ASSIGNMENT_TYPE Automatic assignment 
type

S Both

None

PRM

TAP
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CLOSE_REASON Opportunity close 
reason

E A  (Availability)

C  (Competition)

F  (Function)

P  (Price)

S  (Service)

CONTACT_RANK_ON_OPPOR
TUNITY

Opportunity contact 
rank

U DECISION_MAKER  (Decision 
Maker)

END_USER  (End User)

FLAG Flag S N  (No)

Y  (Yes)

INTEREST_USE Interest Use S COMPANY_CLASSIFICATION 
(Customer Classification)

CONTACT_INTEREST (Contact 
Interest)

LEAD_CLASSIFICATION (Lead or 
Opportunity Classification)

MC_DATE_MAPPING_TYPE Date Mapping Type U E  (End date of a period)

S  (Start date of a period)

METHODOLOGY_TYPE Opportunity 
Methodology Type

E OOP  (Object Oriented)

OPP_ACCESS_PRIVILEGE Opportunity Access 
Privilege

S F  (Full Unrestricted Access)

O  (Full Access by Operating Unit)

P  (Prospecting Access)

T  (Sales Team Access)

OPP_PROBABILITY_LINK Opportunity 
Probability Link

S Error  (New value is not acceptable)

Warning  (Warn user about error)

PLAN_ELEMENT_MAPPING Sales Categories 
Mapping with Sales 
Quotas (CN)

S PCODE  (Map quota to primary 
interest code)

SCODE  (Map quota to secondary 
interest code

TYPE  (Map quota to interest type)

Sales Lookup Description
Access 
Level Seeded Values & Meaning
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PRM_ASSIGNMENT_TYPE PRM assignment type S Broadcast

Serial

Single

Unassigned

PRM_LEAD_TYPE PRM lead type S Direct

Indirect

ROLE_TYPE Role Type U AM  (Account Manager)

PS  (Product Specialist)

SCD_REFRESH_MODE Sales Credit Denorm 
refresh mode

U 1 (Complete refresh)

2 (Incremental refresh)

SCD_RUN_MODE Sales Credit Denorm 
Run Mode

E 1  (Complete)

2  (Update)

UPDATE_ACCESS Update Access S I  (Inherit data)

R  (View data)

U  (Update subordinate’s data)

Sales Lookup Description
Access 
Level Seeded Values & Meaning
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  Oracle Accounts Receivable Lookup Code Values

AR Lookup Description
Access 
Level Seeded Values & Meaning

CONTACT_ROLE_TYPE Contact Role Type E ADMINISTRATIVE_CONTACT_FOR 
(Administrative Contact For)

BILL_PRESENTMENT_ADMIN (Bill 
Presentment System Administrator)

BILL_PRESENTMENT_CSR (Bill 
Presentment System Customer Service 
Representative)

BILL_PRESENTMENT_ORG_REP 
(Bill Presentment System 
Organization Representative)

BILL_PRESENTMENT_SITE_ADMIN 
(Bill Presentment System Site 
Administrator)

BILL_TO (Bill To)

BUYING_CONTACT_FOR (Buying 
Contact For)

CEO_OF (CEO)

CFO_OF (CFO)

CIO_OF (CIO)

CONTACT (Contact)

CORR (Correspondence)

DEPT_HEAD (Department Head)

DUN (Dunning)

EXECUTIVE (Executive)

KEY_DECISION_MAKER_FOR (Key 
Decision Maker)

LEGAL (Legal)

LEGAL_CONTACT_FOR (Legal 
Contact For)
42 Oracle Sales Online Implementation Guide 



Step 11: Oracle Sales Online Lookup Codes
CONTACT_ROLE_TYPE 
(continued)

Contact Role Type E MARKET (Market)

MIDDLE_MANAGER (Middle 
Manager)

PRIMARY_CONTACT_FOR (Primary 
Contact For)

RECEIVING_CONTACT_FOR 
(Receiving Contact For)

SHIPPING_CONTACT_FOR 
(Shipping Contact For)

SHIP_TO (Ship To)

STMTS (Statement)

STOCK_HOLDER_OF (Stock Holder)

TECHNICAL_CONTACT_FOR 
(Technical Contact For)

CONTACT_TITLE Contact Title E DR (Dr.)

MISS (Miss)

MR (Mr.)

MRS (Mrs.)

MS (Ms.)

SIR (Sir)

CUSTOMER_CATEGORY Customer Category E CUSTOMER (Customer)

PROSPECT (Prospect)

AR Lookup Description
Access 
Level Seeded Values & Meaning
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DEPARTMENT_TYPE Department Type U ACCOUNTING

ADMINISTRATION 

CUSTOMER SERVICE

DISTRIBUTION/LOGISTICS

ENGINEERING

FACILITIES

HUMAN RESOURCES

INFORMATION TECHNOLOGY

LEGAL

MANUFACTURING

MARKETING

MERCHANDISING

OPERATIONS

PURCHASING

QUALITY ASSURANCE

R&D (Research & Development)

RISK ANALYSIS

SALES

TRAINING 

INTEREST_TYPE Interest Type E ENTERTAINMENT

HOBBIES

PREFERENCES

SPORTS

TRAITS

LANGUAGE Language E ENG (English)

FRE (French)

GER (German)

ITA (Italian)

SPA (Spanish)

AR Lookup Description
Access 
Level Seeded Values & Meaning
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PARTY_RELATIONS_TYPE Party Relationship Type E ADVERTISER (Advertiser)

AFFILIATE_TO (Affiliate)

AGREEMENT_SIGNER_OF (Party 
that signs agreement on behalf of 
another party)

ASSOCIATE_OF (Associate of)

AUNT (Aunt)

BENEFACTOR_OF (Benefactor of)

BENEFICIARY (Beneficiary)

BILLER_AT (When an organization is 
registered biller)

BILLER_FOR (Biller For)

BILLTO_OF (Alternate billing party 
for the buyer)

BILL_CONSOLIDATOR_AT (Bill 
consolidator at)

BILL_CONSOLIDATOR_FOR (Bill 
Consolidator for)

BILL_PRESENTER_FOR (Bill 
Presenter at)

BILL_PUBLISHER_AT (Bill publisher 
at)

BILL_PUBLISHER_FOR (Bill 
publisher for)

BOARD_MEMBER_OF (Board 
Member)

BROTHER_OF (Brother)

BUSINESS_PARTNER_FOR (Business 
partner

CEO_OF (CEO)

CFO_OF (CFO)

CHANNEL_FOR (Channel)

CHILD_OF (child of)

CIO (CIO)

COMPETITOR_OF (Competitor)

AR Lookup Description
Access 
Level Seeded Values & Meaning
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PARTY_RELATIONS_TYPE 
(continued)

Party Relationship Type E CONSULTANT_FOR (Consultant)

CONTACT_OF (Contact)

CONTAINS_MEMBER (Contains 
member)

COUSIN_OF (Cousin)

CUSTOMER_OF (Customer)

DAUGHTER_OF (Daughter)

DEPENDENT_OF (Dependent)

DIVISION_OF

DOMESTIC_PARTNER_OF (Domestic 
Partner)

DOMESTIC_SUBSIDIARY_OF 
(Domestic subsidiary of)

DOMESTIC_ULTIMATE_OF 
(Domestic Ultimate of)

EMPLOYEE_OF (Employee)

EMPLOYER_OF (Employer)

FATHER_OF (Father of)

FIELD_SERVICE_PROVIDER_FOR 
(Field Service provider)

GENERAL_EMPLOYEE_OF (General 
Employee)

GLOBAL_SUBSIDIARY_OF (Global 
subsidiary of)

GLOBAL_ULTIMATE_OF (Global 
Ultimate of)

GUARANTOR_FOR (Guarantor)

GUARDIAN_OF (Guardian)

HEADQUARTERS_OF (Headquarters 
of)

KEY_DECISION_MAKER_FOR (Key 
decision maker)

LEGAL_COUNSEL_FOR (Legal 
counsel for)

MANAGER_OF (Manager_of)

AR Lookup Description
Access 
Level Seeded Values & Meaning
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PARTY_RELATIONS_TYPE 
(continued)

Party Relationship Type E MEMBER_OF (Member)

MOTHER_OF (Mother)

OWNED_BY (Owned)

PARENT_OF (Parent)

PARTNER_OF (Partner)

PAYFROM_OF (Alternate party to pay 
for a buyer)

PAYTO_OF (Alternate payee name for 
the seller)

PUBLISHER (Publisher)

REFERENCE_FOR (Reference)

_OF (Relative)

REPAIR_DEPOT_PROVIDER_FOR 
(Repair depot provider)

REPORTS_TO (Reports to)

SELLER_FOR (Seller)

SELLER_TO (Seller to)

SHIPTO_OF (Alternate shipping party 
for the buyer)

SIBLING_OF (Sibling)

SISTER_OF (Sister)

SON_OF (Son)

SPOUSE_OF (Spouse)

STOCK_HOLDER_OF (Stockholder)

STUDENT_OF (Student)

SUBSIDIARY_OF (Subsidiary)

THIRD_PARTY_OF (Third party)

UNCLE_OF (Uncle)

VAD_OF (VAD of)

VAR_OF (VAR of)

VENDOR_OF (Vendor)

AR Lookup Description
Access 
Level Seeded Values & Meaning
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PARTY_SITE_USE_CODE Party Site Use Code E ACK (Acknowledgments)

ADMINISTERED_BY (Administered 
By)

BILL_TO (Bill To)

BOL (Bills of Lading)

BUSINESS (Business)

CM (Credit Memos)

COLLATERAL_MAIL_TO (Collateral 
Mail To)

CORR (Correspondence)

CUSTOMER_REGION (Customer 
Region)

DELIVER_TO (Deliver To)

DRAWEE (Drawee)

DUN (Dunning)

GENERAL_MAIL_TO (General Mail)

HEADQUARTERS_FOR 
(Headquarters for)

HOME (Home)

INCORPORATED_TO (Incorporated)

INSTALL_AT (Install At)

INV (Invoice)

ISSUED_BY (Issued By)

KEY_SITE (Key Site)

LEGAL (Legal)

LEGAL_ADDRESS_OF (Legal 
Address)

LEGAL_RESIDENCE_OF (Legal 
Residence)

MARKET (Market)

MARK_FOR (Mark For)

NOT_ALLOWED_INTO (Not 
Allowed Into)

OFFER_TO (Offer to)

AR Lookup Description
Access 
Level Seeded Values & Meaning
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PARTY_SITE_USE_CODE 
(continued)

Party Site Use Code E OTHER (Other)

PAYMENT_WILL_BE_MADE_BY (Be 
Made By)

PAY_TO (Pay To)

REPLY_TO (Reply To)

REPORT_TO (Report To)

RESIDES_AT (Resides At)

SHIP_FROM (Ship From)

SHIP TO (SHIP_TO)

SOLD_TO (Sold To)

STMTS (Statements)

STORE (Store)

SUPPORT_SITE (Support Site)

WORKS_AT (Works At)

WORK_PERFORMED_AT (Work 
Performed At)

PHONE_LINE_TYPE Phone line type E FAX

GEN (General)

IW (Inbound watts)

OW (Outbound watts)

VM (Voice mail)

ASSISTANT (Assistant)

HOME (Home)

MOBILE (Mobile)

OFFICE (Office)

PAGER (Pager)

AR Lookup Description
Access 
Level Seeded Values & Meaning
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Oracle Order Management Lookup Values

Step 12: Setting System Profile Options
Oracle applications let you set up your applications according to your company’s 
business requirements. System profiles define how an application performs for 
users.

The procedure for setting up and changing profile options is the same for all Oracle 
applications. For a detailed description of the procedures, refer to the Oracle 
Applications System Administrator’s Guide.

Profile options can be set at four levels:

■ Site: Indicates that the profile option is set at the site level. The site level setting 
affects the entire database.

RESPONSIBILITY Responsibility E APC (Accounts Payable Clerk)

APS (Accounts Payable Supervisor)

ARC (Accounts Receivable)

ARS (Accounts Receivable Supervisor)

CFO (CFO)

COLCT (Collection)

COLCTSUP (Collection supervisor)

CONTRLR (Controller)

GLC (General ledger clerk)

GLS (General ledger supervisor)

SOC (Sales operation clerk)

SOS (Sales operations supervisor)

TRSUR (Treasurer)

 Order Management Lookup Description
Access 
Level Seeded Values & Meaning

SALES_CHANNEL Sales Channels S DIRECT (Direct)

INDIRECT (Indirect)

AR Lookup Description
Access 
Level Seeded Values & Meaning
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■ Application: Indicates that the profile option is set at the application level. 
When a profile option is set at this level it overrides the site level setting.

■ Responsibility: Indicates that the profile option is set at the responsibility level. 
The responsibility level setting affects users of a given responsibility. When a 
profile option is set at this level it overrides site and application level settings. 

■ User: This setting affects individual users. When set, it overrides values set at 
the site, application, and responsibility levels.

The profile options which can be used for Sales Online have the following prefixes:

■ OS: (Oracle Sales)

■ OSO: (Oracle Sales Online)

■ ASO: (Oracle Order Capture)

■ JTF: (Oracle Foundation)

■ ICX: (Oracle Foundation)

■ HZ: (Trading Community Architecture)

Setting or Changing Profile Options
Use this procedure to set or change profile options.

Steps
1. Choose Oracle Sales Setup > System Profiles under the Oracle Sales 

Administrator responsibility.

The Find System Profile Values window appears.

2. Enter your search criteria in the Display region.

3. Click in the Profile Field. Enter a partial name of the profile using "%" as a wild 
card.

4. Click Find.

The found profiles are displayed in the System Profile Values window.

5. Click in the field of the profile you wish to set or change.

6. Select a value from the List of Vales (LOV).

7. Click Save on the toolbar.
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The following table lists the Sales Online profile names, descriptions, and applicable 
default values and recommended values. An asterisk (*) after a profile name 
indicates that the user can set the profile in Personal Profiles. Italicized profile names 
are reserved for future use. 

Oracle Sales Online Application Profiles

Functional 
Area Profile Name Profile Description

Default 
Value

OSM: Create Tasks Flag AS_SM_CREATE_TASKS

OSO: Search Lead Wildcard ASF_SEARCH_LEAD_WILDCARD

Access OS: Customer Access Privilege Customer Access Privilege (Full, Prospecting, 
Sales Team)

Full

Access OS: Customer Sales Team 
Default Role Type

Customer Sales Team Default Role Type  
(Account Manager or Product Specialist and 
any user defined roles)

Account 
Manager

Access OS: Manager Update Access Manager Update Access

(U) Update

(I) Inherit access privilege

(R) View data

View Data

Access OS: Opportunity Access 
Privilege

Opportunity Access Privilege

Global Full

Full

Prospecting

Sales Team

Global 
Full

Access OS: Sales Admin Update Access Sales Update Admin Access

Update (U)

Inherit access privilege (I)

View Data (R)

View Data 
(R)

Access OS: Sales Lead Access Privilege Lead Access Privileges

Full

Prospecting

Sales Team

Full

Activity OSO: Default Activity Priority* Default Activity Priority High

Activity OSO: Default Activity Status* Default Activity Status Open
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Activity OSO: Default Activity Type* Default Activity Type Appointm
ent

Activity OSO: Default number of days to 
filter tasks

Display tasks for the last <n> days 180

Customer OS: Enable Customer LOV 
Security

AS_ENABLE_CUST_LOV_SECURITY

Determine whether the customer list of values 
will be restricted or not. If set to Yes, customer 
list of values will have security enforced based 
on the profile; OS: Customer Access Privilege 
setting, when creating an opportunity.

No

Customer OS: Execute TCA API Callouts 
for Mobile Sales

AS_HZ_EXECUTE_CALLOUTS N

Customer OSO: Default Address Lines* Default Address Lines 2

Customer OSO: Default Address Type Default Address Type Marketing

Customer OSO: Default Customer 
Category*

Default Customer Category Customer

Customer OSO: Default Organizational 
Relationship*

Default Org Relationship Employer 
of

Customer OSO: Default Person Phone 
Type*

Default Person Phone Type General

Customer OSO: Default Person 
Relationship*

Default Person Relationship Employee

Customer OSO: Default Organization 
Phone Type*

Default Organization Phone Type General

Forecast OS: Daily Conversion Type Currency conversion type for daily conversion 
rates.

Corporate

Forecast OS: Date Mapping Type Currency conversion date Start date 
of a 
period

Forecast OS: Forecast Calendar Name of the calendar you are using to manage 
your forecasts

Forecast OS: Forecast Current Freeze 
Period

Rolling Forecast Current Freeze Period label

Forecast OS: Forecast Freezing Enabled Forecast Freezing for Rolling Forecast enabled 
or not

No

Functional 
Area Profile Name Profile Description

Default 
Value
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Forecast OS: Forecast Price List Price List for Sales Forecast and Opportunity

Forecast OS: Forecast Price Volume 
Margin

Revenue Volume correspondence tolerance 
margin

Forecast OS: Forecast Rolling Calendar 
Periods

Number of periods in forecast rolling calendars

Forecast OS: Forecast Status Confidence Forecast status confidence for MRP integration

Forecast OS: Use Forecast Materialized 
View*

No

Forecast OSO: Default Forecast Currency* Default Forecast Currency

Forecast OSO: Default Forecast Period 
Type*

Default Forecast Period Type None

Forecast OSO: Default Forecast 
Worksheet Lines*

Default Forecast Worksheet Lines 0

Forecast OSO: Display Opportunity 
Worksheet Grand Totals*

Display Opportunity Worksheet Grand Totals 
(Obsolete)

No

Forecast OSO: Display Subordinate 
Current Pipeline*

Display Subordinate Current Pipeline Yes

Forecast OSO: Forecast Autosubmit 
Worksheets

ASF_FRCST_AUTOSUBMIT_WKST

Used to set the default worksheet to be 
submitted when reps submit forecasts.

Null

Forecast OSO: Forecast Calendar Month The number of periods available for forecasting. 3

Forecast OSO: Forecast Max Generate 
Months

ASF_FRCST_MAX_GEN_MONTHS

The maximum number of months that can be 
submitted on the Generate Forecast page.

6

Forecasting OSO: Display Opportunity 
Worksheet Grand Totals

ASF_FRCST_DISPLAY_GRAND_TOTALS

If set to Yes, the total line/numbers will be 
displayed on the opportunity worksheet.

No

Fulfillment JTF_FM_CREATE_DEST (Value)          asfCntctAdsrhMain.jsp                

General FND: Message Level Threshold Success

General OS: Preferred Reporting 
Currency

Preferred Currency for Denorm Programs US Dollar

Functional 
Area Profile Name Profile Description

Default 
Value
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General OSO: Application Utility Class ASF_APPLICATION_UTILITY_CLASS

Used internally by application-not intended to 
be reset

oracle.app
s.asf.util.
OsoAppU
tility

General OSO: Debug Message On No

General OSO: Default Country* Default Country United 
States

General OSO: Default Note Type* Default Note Type User 
Generated 
Note

General OSO: Default Notes Display 
Days*

Display notes for the last <n> days 180

General OSO: Default Sales Group and 
Role*

Default Sales Group and Role to use for log in XXXXX

General OSO: Display Tracking 
Information*

Flag indicates whether to show tracking data Yes

General OSO: Enable Record Count* Enable the record count No

General OSO: Max Attachment Size Determines the maximum attachment size (in 
bytes)

100,000

General OSO: Minimum Search String 
Length

Minimum Search String Length 4

General OSO: Number of News 
Headlines

Number of news items to display for each ticker 
symbol the user selects

5

General OSO: SQL Trace On No

Leads OS: Move Sales Leads AS_MOVE_SALES_LEADS

Opportunity  OS: Maximum Roll Days for 
Converting Amount

Maximum Roll Days for converting amount if 
no conversion rate for a day

Opportunity ASO: Product Organization Org id used in inventory items to display 
(mandatory)

Opportunity OS: Allow Updating Frozen 
Opportunities

When set to yes, users can update frozen 
opportunities

Yes

Opportunity OS: Compensation Sales Credit 
Type

Compensation Sales Credit Type

Functional 
Area Profile Name Profile Description

Default 
Value
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Opportunity OS: Customer Address Required 
for Opportunity Sales Lead

Customer Address Required for Opportunity 
and Sales Lead

No

Opportunity OS: Default Close Date Days* Default Opportunity close date days 30

Opportunity OS: Default Opportunity Sales 
Stage*

Default Sales Stage Stage 1

Opportunity OS: Default Opportunity Status* Default Opportunity Status Prelimina
ry

Opportunity OS: Default Opportunity Win 
Probability*

Default Opportunity Win Probability 10-Prospe
cting 
(Qualified
)

Opportunity OS: Default Sales Channel* Default Sales Channel Direct

Opportunity OS: Forecast Sales Credit Type Forecast Credit Type for Opportunity Sales 
Credits (mandatory)

Opportunity OS: Generate Opportunity 
System Notes

Determines whether or not notes are generated 
when parts of the opportunity change

Yes

Opportunity OS: Inventory Category 
Integration

Flag to populate inventory categories for Oracle 
Sales

Yes

Opportunity OS: Move Opportunities AS_MOVE_OPPORTUNITIES

Opportunity OS: Opportunity Probability 
Link

Determines whether a warning or an error is 
given if the win probability amount does not 
fall within the sales stages probabilities

Warning

Opportunity OS: Opportunity Sales Credit 
Enforce Sales Team Definition

Salesperson cannot be removed from the sales 
team if they have sales credits

Yes

Opportunity OS: Opportunity Sales Team 
Default Role Type

AS_DEF_OPP_ST_ROLE

The role set with this profile will be used as 
default when creating sales team entry for 
opportunity.

Null

Opportunity OS: Sales Methodology* Sales Methodology Object 
Oriented

Opportunity OS: Sales Team Creator Keep 
Flag

Default keep flag for sales team creator

Opportunity OSO: Default Sales Methodology ASF_DEFAULT_SALES_METHODOLOGY Object 
Oriented

Functional 
Area Profile Name Profile Description

Default 
Value
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Opportunity OSO: Enable Lead Share Display Opportunity Exchange button No

Opportunity OSO: Enable Product Category 
in Opportunity Advanced 
Search

ASF_PRODUCT_CATEGORY_SEARCH

This profile is used in Opportunity Advanced 
Search. If set to Yes, then product category 
multi-select list will show up and let users 
search on product category.

Null

Opportunity OSO: Enable Quote If set to yes, displays Create Quote button on 
Opportunity page.

No

Opportunity 
Exchange

OSO: Lead Share Mail CC In case of error in the data send and fetch 
between partners, an email is carbon copied to 
this user.

Opportunity 
Exchange

OSO: Lead Share Mail From In case of an error in the data send and fetch 
between partners, an email is sent from this 
user.

Opportunity 
Exchange

OSO: Lead Share Mail To In case of error in the data send and fetch 
between partners, an email is sent to this user.

Opportunity 
Exchange

OSO: Lead Share Send Flag Y/N Send email when an API error occurs 
during send or fetch data between partners.

N

Opportunity

Exchange

OSO: Enable Lead Share The profile option to enable opportunity 
sharing throughout the system

No

Opportunity

Exchange

OSO: Lead Share Application ID Application ID 522

Opportunity

Exchange

OSO: Lead Share Company 
Code

The company code which you registered on the 
LETS server

Opportunity

Exchange

OSO: Lead Share Host Name The host name of the LETS server

Opportunity

Exchange

OSO: Lead Share Partner ID Partner ID generated from the LETS server

Opportunity

Exchange

OSO: Lead Share Port Number The port number of the LETS server

Opportunity

Exchange

OSO: Lead Share Proxy Host The proxy host name of the LETS server

Functional 
Area Profile Name Profile Description

Default 
Value
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Opportunity

Exchange

OSO: Lead Share Proxy Port The port number of the proxy host name of the 
LETS server

Opportunity

Exchange

OSO: Lead Share Responsibility 
ID

The default responsibility of the sales person 
who is assigned the opportunities

Partner PV: Default Vendor Org

Partner PV: User Type Sales Rep

Preferences ICX: Date Format Mask* Date Format Mask 31-Dec-99

Preferences ICX: Language* Language American 
English

Preferences JTF_PROFILE_DEFAULT_APPLI
CATION

(Value) 522. This profile option must be set at 
the user level only

Preferences JTF_PROFILE_DEFAULT_BLAN
K_ROWS*

Number of blank rows to show in table to create 
new rows

3

Preferences JTF_PROFILE_DEFAULT_CSS* This profile must be set at the user level only. jtfucss.css

Preferences JTF_PROFILE_DEFAULT_CURR
ENCY*

USD

Preferences JTF_PROFILE_DEFAULT_NUM
_ROWS*

Number of rows of data to display in table 15

Preferences JTF_PROFILE_DEFAULT_RESP
ONSIBILITY*

(This profile must be set at the user level only. 
(Values) The values are seeded responsibilities: 
User (22405), Manager (22406), Administrator 
(22477).

Sales Comp OSO: Default Sales Comp Period 
Type

Default Sales Comp Period Type

Territory HZ: Execute API Call Outs Yes

Territory OS: Enable Real Time 
Opportunity and Customer 
Assignment

AS_ENABLE_ONLINE_TAP

If set to Yes, customer and opportunity sales 
team will be created and updated at the time of 
creating and updating opportunity and 
customer.

No

Territory OS: Territory Minimum Number 
of Records for Parallel 
Processing

Minimum number of records for parallel 
processing

100

Functional 
Area Profile Name Profile Description

Default 
Value
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Step 13: Setting Up Note Types
Oracle Notes is a CRM Foundation Component. Oracle Notes comes with a set of 
predefined note types. You may choose not to use the predefined note types and 
create customized note types of your own. Or, you can use both the predefined set 
and additional customized note types.

Refer to the Implementing Notes section of the Oracle CRM Foundation 
Implementation Guide for additional information about setting up Oracle Notes.

Use the following procedure to set up note types.

Steps
1. Choose CRM Foundation >Notes Setup> Note Type Setup under the Sales 

Administrator responsibility.

The Application Object Library: Note Type Lookups window appears.

2. Define the code, meaning, and description as desired. It is only necessary to 
define a tag for a new, customized note type.

3. Save the record when you are finished.

Territory OS: Territory Number of Child 
Processes

Number of Child Processes 1

Territory OS: Territory Records to Commit Maximum number of records to commit for 
AS_TERRITORY_ACCESSES and 
AS_ACCESSES tables

1000

Territory OS: Territory Records to Open 
for Processing Changed 
Accounts

Number of records to process per open cursor 
period, for processing changed accounts

10,000

Upgrade OS: Interest type master org id AS_INT_MASTER_ORG_ID

Master org id is required for Marketing Online 
interest type migration script. It is used while 
upgrading from 3i to lli.

Wireless JTFW_PROFILE_DEFAULT_WIRELESS_R
ESPONSIBILITY

Functional 
Area Profile Name Profile Description

Default 
Value
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Deleting an Existing Note Type
Assign an end date to an existing note type to delete it.

Mapping Note Types to a Source
When you map a note type to a source object, you limit the visible note types for 
that source to the defined subset of note types. 

Step 14: Setting Up Territory Management 
Refer to the Implementing Territory Manager section of the Oracle CRM 
Foundation Implementation Guide for information about setting up territories in 
the territory manager.

Steps
1. Run the concurrent program "Generate Territory Package".

2. Run the concurrent program "Territory Denormalization Refresh". 

You can assign sales team members using two modes:

■  Batch mode 

In this mode you must schedule the "Assign Territory Access" concurrent 
program to run at specific intervals.

■  Online Mode 

If you set the profile option, "OS: Enable Real Time Opportunity and Customer 
Assignment", to Yes, customer and opportunity sales teams are created and 
updated based upon territory guidelines.

Please note the following: 

If the profile option "OS: Enable Real Time Opportunity and Customer 
Assignment" is set to "No", you can still assign opportunities and customers 
using the batch mode.

If the profile option "OS: Enable Real Time Opportunity and Customer 
Assignment" is set to "Yes", and you do not use the batch mode, then if the 
territory setup is changed, the sales team assignments to opportunities and 
customers will not reflect these changes unless the batch program is run.
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Step 15: Setting Up Task Manager

Steps
1. Choose CRM Foundation > Task Manager > Setup.

Sales Online Task functionality includes the following:

1. Defining Task Status (Status Transition and Rules is not supported).

2. Defining Task Priorities.

3. Defining Task Types (Resource Requirements and Workflow are not 
supported).

4. Defining Task Templates (Dependencies and recurrences are not 
supported).

Step 16: Setting Up Interaction History
Refer to the Implementing Interaction History section of the Oracle CRM Foundation 
Implementation Guide for information about setting up Interaction History.

Step 17: Setting Up Marketing Encyclopedia
For more information about Marketing Encyclopedia, see Oracle Marketing 
Encyclopedia Concepts and Procedures.

Step 18: Setting Up Marketing Campaigns
Refer to the Oracle Marketing Concepts and Procedures guide for information about 
this topic.

Step 19: Setting Up Fulfillment
Refer to the 1-to-1 Fulfillment section of the Oracle CRM Foundation Implementation 
Guide for information about setting up Fulfillment.

Step 20: Setting Up Partners
Refer to the Oracle Partner Relationship Management Implementation Guide for 
information about setting up Partners.
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Step 21: Setting Up Compensation
Refer to the Oracle Sales Compensation Implementation Guide for information about 
setting up Compensation.

Step 22: Running Concurrent Programs
Sales Online includes a number of programs that perform functions on groups of 
records in the database. These batch programs run on the server and are called 
concurrent programs.

For detailed instructions on running and maintaining concurrent programs, refer to 
the Oracle Applications User’s Guide and the Oracle Applications System Administrator’s 
Guide.

Concurrent Programs Used by Sales Online
Sales Online includes the following concurrent programs:

Oracle Sales Online Concurrent Programs

Concurrent Program 
Name Description

Recommended Run 
Frequency

Assign Territory Accesses 
(optional)

This concurrent program assigns new territory 
access to sales force employees. The program 
prepares database tables for parallel processing. 
It requires setting two profile options: 

OS: Territory Minimum Number of Records for 
Parallel Processing

OS: Territory Number of Child Processes

Run this program after 
completing the setups Setting 
Up Territory Management, and 
after the JTF Concurrent 
programs, "Generate Territory 
Package" and "Territory 
Denormalization Refresh" have 
been run.

Autocreate Opportunity 
from Sales Lead

Create opportunities from existing sales leads.

Parameters are: Debug Mode or Trace Mode

This program should be run 
after the Import Sales Leads 
program.

Generate Access Records 
(optional) 

This is a child program of Assign Territory 
Accesses

This program does not require 
running separate from Assign 
Territory Access.

Import Sales Leads This program imports sales leads from the 
interface table.

According to business needs
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Incremental refresh of 
AS_MC_SALES_CREDITS_
DEN

Used to refresh sales credits multi-currency 
table. 

This program should be run 
after adding any new reporting 
currencies (using Reporting 
Currency Mapping form) or 
after changing any conversion 
rates or profile options related 
to multi-currency setup.

Incremental refresh of 
AS_SALES_CREDITS_DEN

From, To Run this program to set up 
home page

Run this program every time 
you apply a patch

Initial Build of Forecast 
Summary Tables 
(mandatory)

This program will build the materialized view 
used for forecasting.

This program must be run 
initially before users can 
forecast.

Initial Build of Opportunity 
and Lead Bins (mandatory)

Used for the Opportunity home page bins. This 
program must be run initially before users can 
set up opportunity bins. This program loads the 
opportunity and leads materialized view with 
sales credit information. No parameters are 
needed. 

This program must be run 
anytime the 
as_sales_credit_denorm is 
rebuilt or when values such as 
sales stages and statuses have 
changed. You should also run 
when Refresh 
AS_PERIOD_DAYS is run.
Run this program every time 
you apply a patch.

Initial Load for Leads 
Reports

 Run this program every time 
you apply a patch.

Initial Load for 
Opportunities Reports

 Run this program every time 
you apply a patch.

Load Interest Types and 
Codes to Inventory 
Categories (Load 
Categories)

This concurrent program creates inventory 
categories under the inventory category set 
"Oracle Sales and Marketing" for each 
combination of interest types and codes. In 
order to use this concurrent program, the OS: 
Inventory Category Integration profile value 
must be set to Yes.

Load Sales Lead Interface 
Table from Flat File

This program imports sales leads data from a 
flat file into an interface table.

According to business needs

Concurrent Program 
Name Description

Recommended Run 
Frequency
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Opportunity Exchange-Get 
Opportunities

This program will poll the LETS server and 
retrieve the relevant partner opportunity 
details. 

This program should be run at 
regular intervals by users with 
Opportunity Exchange 
privileges.

Opportunity Exchange-Push 
Opportunities

This program will send the information to the 
LETS server to be picked up by the partners.

This program should be run at 
regular intervals by users with 
Opportunity Exchange 
privileges.

OTS: Lead Generate Use this program to import sales leads from the 
interface. If you want to import data from a flat 
file, you must first run OTS: Load Sales Lead, 
which will move data from the flat file to the 
interface table.

This program must be run 
before Auto Create 
Opportunity from Sales Lead. 
This moves data from the 
interface table to 
AS_SALES_LEADS, 
AS_SALES_LEADS_LINES, 
and 
AS_SALES-LEAD_CONTACTS
.

Refresh AS_PERIOD_DAYS 
table (mandatory)

This program must be run 
before you can run the Refresh 
of as_sales_credits_denorm (in 
complete mode), Initial Build 
of Opportunity Bins, and the 
Build Materialized View for 
Forecast Main Page. This 
sequence of programs must be 
rerun if the GL period 
definitions are changed.

Refresh of 
AS_SALES_CREDITS_DEN
ORM (Complete and 
Incremental)

Used for opportunity reports and forecasting 
functionality. 

Parameters are:

Refresh Mode

Complete refresh=Use this mode when running 
for the first time or doing a complete refresh).

Incremental Refresh=Run in this mode for an 
incremental refresh.

This program must be run 
before user can run 
opportunity reports and 
perform forecasting functions.

Refresh of Forecast 
Summary Tables 
(mandatory)

This program is used to refresh the materialized 
view used for forecasting.

This program should be run 
periodically.

Refresh of Leads Bins Data  Run daily

Concurrent Program 
Name Description

Recommended Run 
Frequency
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Running Concurrent Programs
Every time you apply a patch the following concurrent programs must be run.

■ Initial Build of Opportunity Bins

■ Refresh of Opportunity Bins Data

■ Refresh Lead Bins Data

Use the following procedure to run concurrent programs.

Steps
1. Under the Sales Administrator responsibility, choose Requests > Run.

2. Select Single Request.

3. Enter the name of the desired concurrent program, or select from the list of 
values.

4. Enter parameters.

5. Click Submit.

Refresh of Leads Reports This program is used to refresh the leads 
reports.

Refresh of Opportunity Bins 
Data (mandatory)

This program is used to run an incremental 
refresh of the materialized view used for the 
opportunity bins. This program should be 
scheduled to run periodically.

Users will not see 
opportunities in bins created 
after the last refresh of "refresh 
sales credit".

Refresh of Opportunity 
Reports

This program is used to refresh the opportunity 
reports.

 

Setup Checking for Oracle 
Sales Application

This program validates Sales Setups and 
produces an error log that the System 
Administrator can use to diagnose invalid 
setups.

Parameters are:

Upgrade-Yes/No

 

Concurrent Program 
Name Description

Recommended Run 
Frequency
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Step 23: Setting Up Descriptive Flexfields
Refer to the Oracle Applications Flexfield Guide for detailed information about setting 
up descriptive flexfields.

Descriptive flexfields that use table validation or are dependent flexfields are not 
supported in Sales Online.

Step 24: Setting Up Blind Search for LOV (list of values)
You can use an AK region, ASF_LOV_BLIND_SEARCH, to relax the blind search 
restrictions. This region contains the names for the LOVs that should be excluded 
from the blind search restriction.

Please note, this function applies to lists of values that are above or in tables only.

Steps
1. Navigate (AK Developer) Define Regions > Query 

ASF_LOV_BLIND_SEARCH > Click the Region Items button.

2. Add the LOVs attribute ID as a region item for this region. Attribute Type 
(Attribute), Application (Oracle Sales Online), Attribute Name (See table 
below), Sequence (#), Item Style (text).

3. Bounce the Apache (mid-tier) and clear the cache.

LOV Attribute IDs

Attribute IDs List of Values (LOVs)

ASF_FS_CAMPAIGN_LOV Campaign

ASF_FS_CMPTR_LOV Competitor

ASF_FS_CSTMR_LOV Customer

ASF_FS_EMPLY_LOV Employee

ASF_FS_OPPTY_LOV Opportunity

ASF_FS_ORGADDR_LOV Organization Address

ASF_FS_ORGZN_ADDRE_LOV Organization Address in Person Detail

ASF_FS_ORGZN_LOV Organization

ASF_FS_PERSN_LOV Person

ASF_FS_PRDCT_LOV Product
66 Oracle Sales Online Implementation Guide 



Step 25: Setting Up Lead Import and Import Leads
Step 25: Setting Up Lead Import and Import Leads
Importing leads into the database requires you to:

1. Set up lead import.

2. Import leads from a flat file or populate the lead interface table.

3. Check for and fix any errors.

The About Existence Checking section at the end of this step gives you a 
detailed overview of duplicate checking.

25a) Setting Up Lead Import
Use this procedure to set up lead import.

Steps
1. Set up system profile options for lead import.

Three are used by the TCA API to generate keys for customers, addresses, and 
contacts:

■ HZ: Key Word Count

The number you enter in this profile option determines how many words in 
the customer name are used to generate keys. For example, a setting of 2 
means that only the first two words in the name are used. 

■ HZ: Address Key Length

ASF_FS_PRJCT_LOV Project

ASF_FS_PRTNR_LOV Partner

ASF_FS_PURLN_LOV Purchase Lines

ASF_FS_RELAT_LOV Relationship

ASF_FS_SALESREP_LOV Sales Rep

ASF_FS_SALESREP_SEC_LOV Sales Rep with Security

ASF_FS_SLSGP_LOV Sales Group

ASF_FS_SIC_LOV SIC code (Standard Industry Code)

Attribute IDs List of Values (LOVs)
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■ HZ: Postal Code Key Length

The following system profile option is used by the lead import process itself: 

■ OS: Default Resource ID Used for Sales Lead Assignment

Set this system profile option to the resource who is to handle any leads that 
are not assigned to any current territory.

2. Set up word replacement rules by logging in under the Receivables Manager 
Responsibility and navigating to Setup > Word Replacement Rules.

3. Run the following concurrent programs:

■ Generate Territory Packages. This concurrent program, available by logging 
in under the CRM Administration responsibility, builds the API that returns 
the winning territories which are defined in territory setup. It must be run 
at least once before you import leads and each time after you modify the 
territory setup. You need not run this program every time you import leads.

■ Territory Denormalization Refresh. This program, available by logging in 
under the CRM Administration responsibility, creates a search index for faster 
performance of the territory management module. It must be run at least once 
before you import leads and each time after you modify the territory setup. 
You need not run this program every time you import leads.

■ Generate Keys for Fuzzy Match. This program, available by logging in 
under the Receivable Manager responsibility, generates the keys for 
customer records already in the database. This program must be run before 
you import leads for the first time and anytime you change the lead import 
system profile options listed above, but you need not run it every time you 
import leads. The application generates keys for imported leads 
automatically.

25b) Import Leads from a File or Populate the Lead Interface Table
Use this procedure to import leads into the database from a flat file or by entering 
data directly into a lead interface table. The lead import assigns the leads 
automatically to the appropriate agents via the Oracle eBusiness suite’s Territory 
Management module.

Prerequisites
■ You must be familiar with running concurrent programs as described in the 

Oracle Applications Systems Administrator’s Guide.
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■ You must be familiar with Oracle SQL Loader as described in the Oracle 8i 
Utilities guide.

■ You must be familiar with running SQL Plus database queries.

■ Before importing leads you must successfully run the following concurrent 
programs:

* Generate Territory Packages. This concurrent program, available by 
logging in under the CRM Administration responsibility, builds the API 
that returns the winning territories which are defined in territory setup. 
It must be run at least once before you import leads and each time after 
you modify the territory setup. You need not run this program every 
time you import leads.

* Territory Denormalization Refresh. This program, available by logging in 
under the CRM Administration responsibility, improves the performance 
of the territory management module by creating a search index. It must be run 
at least once before you import leads and each time after you modify 
the territory setup. You need not run this program every time you 
import leads.

* Generate Keys for Fuzzy Match. This program, available by logging in 
under the Receivable Manager responsibility, generates the keys for 
customer records already in the database. This program must be run 
before you import leads for the first time and anytime you change the 
lead import system profile options listed above, but you need not run it 
every time you import leads. The application generates keys for 
imported leads automatically.

Steps
1. To import leads from a file:

a. FTP the tab-delimited file with lead data to a directory on the server. The 
file must have a file name with the extension .dat and the structure 
described in the Guidelines section below. 

b. In the same directory, create an Oracle SQL Loader parameter file. This file, 
which the Lead Import program refers to as the P_DATAFILE can have any 

Note: The data in your import file must contain the required fields 
and the Load Status of each record must be NEW. 
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name of your choosing. Here is what a sample P_DATAFILE file may look 
like:

userid=<username>/<password>
control=ASTSLIMP.CTL
data=<path><lead import data file name>.dat

Please refer to Oracle 8i Utilities guide for more information. 

c. Log in under the Oracle TeleSales Administration responsibility. 

d. Run the Load Sales Lead Interface Table from Flat File concurrent program. 
This program populates the lead interface table 
(AS_IMPORT_INTERFACE). To run the program you must know the 
absolute path to the P_DATAFILE you created in the previous step.

2. After loading leads into the lead interface table, run the Lead Import concurrent 
program. This program:

■ Checks the validity of the data in the leads you are importing. Any records 
that are missing data in required fields or contain corrupt data are not 
imported. They remain in the lead interface table and are flagged by the 
program with the load status of Error.

■ Checks the database for duplicates of customer, address, contact, contact 
point, and restriction information before creating new records. Please see 
About Existence Checking below for a detailed explanation.

■ Generates customer keys for all new parties created in the database. 

■ Assigns the imported leads to the sales territories set up in the CRM 
Territory Management module. If the program does not find a territory to 
match an imported lead, then it assigns that lead to the person selected in 
the system profile option OS: Default Resource ID Used for Lead 
Assignment. If you do not set this profile, the leads are assigned to the user 
who is running the program.

Note: The concurrent program checks for duplicate customer 
records by comparing the data being imported and existing 
customer records. It does not check for duplicates in the data you 
are importing itself. This means that if you have duplicate entries in 
the data you import, the program will create the same duplicates in 
the database.
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3. After the Lead Import program has run successfully, you are ready to check for 
and correct any errors.

Guidelines
The flat file you are importing leads from must be a tab-delimited file. The file name 
must have the extension .dat (For example, mynewleads.dat). Each lead must 
contain the fields listed in the table below. Please note:

■ As the leads you import are not deleted from the interface table 
AS_IMPORT_INTERFACE even after they are successfully imported into the 
database, you should enter different batch ID in each import file to make sure 
you can distinguish between runs. 

■ You must provide valid values to these columns. This means running SQL*Plus 
queries to obtain some of the values required by this table. The columns you 
must query and sample queries for your use are listed in the Valid Values 
column.

■ Lead import records can contain null fields except for the required fields noted 
below. 

■ A Yes entry in the Table Requires Entry column means that a null or incorrect 
entry in the field results in a database error. 

■ A Yes entry in the Import Requires Entry column means that the import of the 
record will fail if this field is null or of the wrong data type.

.

Note: The lead import concurrent program may run without any 
errors, but you may still have corrupt or missing data in the 
imported leads. You must check for errors in your data to ensure 
that leads have been successfully imported. The program writes 
errors into the as_lead_import_errors table.

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments

IMPORT_INTERFACE_ID NUMBER Yes Yes as_import_interface_s

LAST_UPDATE_DATE DATE Yes Yes

LAST_UPDATED_BY NUMBER Yes Yes

CREATION_DATE DATE Yes

CREATED_BY NUMBER Yes
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LAST_UPDATE_LOGIN NUMBER Yes Yes

REQUEST_ID NUMBER  ]

] The concurrent program 

] generates these values

]

]

]

]

PROGRAM_
APPLICATION_ID

NUMBER  

PROGRAM_ID NUMBER  

PROGRAM_UPDATE_
DATE

DATE  

IMP_LIST_HEADER_
NUMBER

VARCHAR
2(30)

 Yes

LOAD_TYPE VARCHAR
2(20)

 Yes LEAD_LOAD Must be in uppercase letters

LOAD_DATE DATE Yes Yes

LOAD_STATUS VARCHAR
2(20)

 Yes NEW Must be in uppercase letters

LOAD_ERROR_
MESSAGE

VARCHAR
2(2000)

 

PROMOTION_ID NUMBER  select source_code_id from 
ams_source_codes where 
source_code = <as_import_
interface_rec>.promotion_id 
and active_flag = 'Y’

'Used for creating the sales 
lead header.

PROMOTION_CODE VARCHAR
2(50)

Yes select source_code from 
ams_source_codes where 
arc_source_code_for = 
'CAMP' and active_flag = 'Y'

If promotion_id is null then 
this is used for creating the 
sales lead header.

CUSTOMER_ID NUMBER(
15)

CUSTOMER_NAME VARCHAR
2(255)

Yes

CUSTOMER_NUMBER VARCHAR
2(30)

CUSTOMER_STATUS VARCHAR
2(1)

A Must be uppercase. A stands 
for active.

CUSTOMER_TYPE VARCHAR
2(30)

Obsolete. 

CUSTOMER_PROSPECT_
CODE

VARCHAR
2(30)

Obsolete.

CUSTOMER_CLASS_
CODE

VARCHAR
2(30)

Obsolete.

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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SALES_CHANNEL_
CODE

VARCHAR
2(30)

select sales_channel_code, 
sales_channel, description 
from aso_i_sales_channels_v 
where enabled_flag = ’Y’

Obsolete.

SIC_CODE VARCHAR
2(30)

ar_lookups.lookup_code 
where lookup_type = ’1987 
SIC’ and enabled_flag = ’Y’

ANALYSIS_FY VARCHAR
2(5)

Analysis physical year - no 
List of Values

CUSTOMER_
CATEGORY_CODE

VARCHAR
2(30)

ar_lookups.lookup_code 
where lookup_type = 
'CUSTOMER_CATEGORY' 
and enabled_flag='Y'

'

CUSTOMER_GROUP_
CODE

VARCHAR
2(30)

Leave this field null. Obsolete.

CUSTOMER_KEY VARCHAR
2(50)

Leave this field null. Obsolete.

CUSTOMER_
SUBGROUP_CODE

VARCHAR
2(30)

Leave this field null. Obsolete.

FISCAL_YEAREND_
MONTH

VARCHAR
2(30)

Free text format

NET_WORTH NUMBER Free text format.

NUM_OF_EMPLOYEES NUMBER(
15)

Free text format.

POTENTIAL_REVENUE_
CURR_FY

NUMBER

POTENTIAL_REVENUE_
NEXT_FY

NUMBER

CUSTOMER_RANK VARCHAR
2(30)

Obsolete.

REFERENCE_USE_FLAG VARCHAR
2(1)

Obsolete.

TAX_CODE VARCHAR
2(50)

Obsolete.

TAX_REFERENCE VARCHAR
2(50)

Obsolete.

THIRD_PARTY_FLAG VARCHAR
2(1)

Obsolete.

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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COMPETITOR_FLAG VARCHAR
2(1)

Obsolete.

YEAR_ESTABLISHED NUMBER(
4)

ADDR_DO_NOT_MAIL_
FLAG

VARCHAR
2(1)

If set to ’Y’, no mails to 
customer site will be sent.

URL VARCHAR
2(2000)

ADDRESS_ID NUMBER(
15)

CONT_DO_NOT_MAIL_
FLAG

VARCHAR
2(1)

If set to ’Y’, no mails will be 
sent to contact.

ADDRESS_STATUS VARCHAR
2(1)

A

COUNTRY VARCHAR
2(60)

Yes select territory_short_name, 
territory_code, description 
from fnd_territories_vl

If country is supplied then 
address1 needs to be 
supplied and vice-versa.

ADDRESS1 VARCHAR
2(240)

Yes

ADDRESS2 VARCHAR
2(240)

Yes

ADDRESS3 VARCHAR
2(240)

ADDRESS4 VARCHAR
2(240)

CITY VARCHAR
2(60)

Yes select distinct location_
segment_description, 
location_segment_user_
value from ar_location_
values where location_
segment_qualifier = ’CITY’

POSTAL_CODE VARCHAR
2(60)

Yes select min(p.from_postal_
code), max(p.to_postal_
code) from ar_postal_code_
ranges_v p, ar_location_
values a where p.location_
segment_id = a.location_
segment_id and a.location_
segment_qualifier||’’ = 
’CITY’ and a.location_
segment_value like ’X%’

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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STATE VARCHAR
2(60)

Yes select distinct location_
segment_description, 
location_segment_user_
value from ar_location_
values where location_
segment_qualifier = ’STATE’

PROVINCE VARCHAR
2(60)

Yes select distinct location_
segment_description, 
location_segment_user_
value from ar_location_
values where location_
segment_qualifier = 
’PROVINCE’

COUNTY VARCHAR
2(60)

Yes select distinct location_
segment_description, 
location_segment_user_
value from ar_loaction_
values where location_
segment_qualifier = 
'COUNTY’

SITE_CONTACT_ID NUMBER(
15)

    

EMAIL_ADDRESS VARCHAR
2(240)

Yes

SEX_CODE VARCHAR
2(30)

SALUTATION VARCHAR
2(60)

No LOV Use this field for terms used 
for greeting the contact or 
for addressing a letter.For 
example, Excellency.

LAST_NAME VARCHAR
2(50)

TITLE VARCHAR
2(30)

ar_lookups.lookup_code 
where lookup_type = 
'CONTACT_TITLE' and 
enabled_flag = 'Y'

FIRST_NAME VARCHAR
2(40)

Yes Only first name is required.

JOB_TITLE VARCHAR
2(50)

Yes Free text may not be 
validated.

PHONE_ID NUMBER

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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PHONE_NUMBER VARCHAR
2(25)

Yes If possible area code should 
be separated if not the 
whole number will be stored 
in number.

PHONE_STATUS VARCHAR
2(1)

Yes A 

PHONE_TYPE VARCHAR
2(30)

ar_lookups.lookup_code 
where lookup_type = 
’PHONE_LINE_TYPE’ and 
enabled_flag=’Y’

AREA_CODE VARCHAR
2(10)

EXTENSION VARCHAR
2(20)

LEAD_NUMBER VARCHAR
2(30)

STATUS_CODE VARCHAR
2(30)

select status_code from as_
statuses_b where lead_flag = 
’Y’ and enabled_flag = ’Y’ 
and usage_indicator in 
(’ALL’,’OS’)

SOURCE_PROMOTION_
ID

NUMBER Null. Not used by the program.

INITIATING_CONTACT_
ID

NUMBER

CONTACT_ROLE_CODE VARCHAR
2(30)

select lookup_code from as_
lookups where lookup_type 
= ’LEAD_CONTACT_ROLE’

CHANNEL_CODE VARCHAR
2(30)

select sales_channel_code 
from aso_i_sales_channels_v

BUDGET_AMOUNT NUMBER

BUDGET_STATUS_CODE VARCHAR
2(30)

select lookup_code from as_
lookups where lookup_type 
= ’BUDGET_STATUS’

CURRENCY_CODE VARCHAR
2(15)

select currency_code from 
fnd_currencies where 
enabled_flag = ’Y’

DECISION_TIMEFRAME_
CODE

VARCHAR
2(30)

select lookup_code from as_
lookups where lookup_type 
= ’DECISION_
TIMEFRAME’

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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CLOSE_REASON VARCHAR
2(30)

select lookup_code from as_
lookups where lookup_type 
= ’CLOSE_REASON’

LEAD_RANK_CODE VARCHAR
2(30)

Obsolete. Do not populate.

PARENT_PROJECT VARCHAR
2(80)

DESCRIPTION VARCHAR
2(2000)

STATUS_CODE_1 VARCHAR
2(30)

Obsolete.

INTEREST_TYPE_ID_1 NUMBER as_interest_types_v.interest_
type_id where master_
enabled_flag = 'Y' 

PRIMARY_INTEREST_
CODE_ID_1

NUMBER as_interest_codes_v.interest_
code_id where interest_
type_id = <interest_type_id_
1>

SECONDARY_
INTEREST_CODE_ID_1

NUMBER as_interest_codes_v.interest_
code_id where parent_
interest_code_id = 
<primary_interest_code_id_
1>

You must make an entry if 
you entered a primary_
interest 

INVENTORY_ITEM_ID_1 NUMBER AS_INV_ITEM_LOV_
V.INVENTORY_ITEM_ID

ORGANIZATION_ID_1 NUMBER AS_INV_ITEM_LOV_
V.ORGANIZATION_ID 
where inventory_item_id = 
<inventory_item_id_1>

UOM_CODE_1 VARCHAR
2(3)

AS_INV_UOM_V.UOM_
CODE where inventory_
item_id = <inventory_item_
id_1> and organization_id = 
<organization_id_1>

QUANTITY_1 NUMBER

BUDGET_AMOUNT_1 NUMBER

STATUS_CODE_2 VARCHAR
2(30)

INTEREST_TYPE_ID_2 NUMBER

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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PRIMARY_INTEREST_
CODE_ID_2

NUMBER

SECONDARY_
INTEREST_CODE_ID_2

NUMBER

INVENTORY_ITEM_ID_2 NUMBER

ORGANIZATION_ID_2 NUMBER

UOM_CODE_2 VARCHAR
2(3)

QUANTITY_2 NUMBER

BUDGET_AMOUNT_2 NUMBER

STATUS_CODE_3 VARCHAR
2(30)

INTEREST_TYPE_ID_3 NUMBER

PRIMARY_INTEREST_
CODE_ID_3

NUMBER

SECONDARY_
INTEREST_CODE_ID_3

NUMBER

INVENTORY_ITEM_ID_3 NUMBER

ORGANIZATION_ID_3 NUMBER

UOM_CODE_3 VARCHAR
2(3)

QUANTITY_3 NUMBER

BUDGET_AMOUNT_3 NUMBER

STATUS_CODE_4 VARCHAR
2(30)

INTEREST_TYPE_ID_4 NUMBER

PRIMARY_INTEREST_
CODE_ID_4

NUMBER

SECONDARY_
INTEREST_CODE_ID_4

NUMBER

INVENTORY_ITEM_ID_4 NUMBER

ORGANIZATION_ID_4 NUMBER

UOM_CODE_4 VARCHAR
2(3)

QUANTITY_4 NUMBER

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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BUDGET_AMOUNT_4 NUMBER

STATUS_CODE_5 VARCHAR
2(30)

INTEREST_TYPE_ID_5 NUMBER

PRIMARY_INTEREST_
CODE_ID_5

NUMBER

SECONDARY_
INTEREST_CODE_ID_5

NUMBER

INVENTORY_ITEM_ID_5 NUMBER

ORGANIZATION_ID_5 NUMBER

UOM_CODE_5 VARCHAR
2(3)

QUANTITY_5 NUMBER

BUDGET_AMOUNT_5 NUMBER

INTERACTION_NOTES_1 VARCHAR
2(2000)

PRIORITY_1 NUMBER(
3)

TODO_DATE_1 DATE

TODO_START_TIME_1 VARCHAR
2(5)

ACTIVITY_CODE_1 VARCHAR
2(30)

INTERACTION_NOTES_2 VARCHAR
2(2000)

PRIORITY_2 NUMBER(
3)

TODO_DATE_2 DATE

TODO_START_TIME_2 VARCHAR
2(5)

ACTIVITY_CODE_2 VARCHAR
2(30)

INTERACTION_NOTES_3 VARCHAR
2(2000)

PRIORITY_3 NUMBER(
3)

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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TODO_DATE_3 DATE

TODO_START_TIME_3 VARCHAR
2(5)

ACTIVITY_CODE_3 VARCHAR
2(30)

INTERACTION_NOTES_4 VARCHAR
2(2000)

PRIORITY_4 NUMBER(
3)

TODO_DATE_4 DATE

TODO_START_TIME_4 VARCHAR
2(5)

ACTIVITY_CODE_4 VARCHAR
2(30)

INTERACTION_NOTES_5 VARCHAR
2(2000)

PRIORITY_5 NUMBER(
3)

TODO_DATE_5 DATE

TODO_START_TIME_5 VARCHAR
2(5)

ACTIVITY_CODE_5 VARCHAR
2(30)

INTERACTION_NOTES_6 VARCHAR
2(2000)

PRIORITY_6 NUMBER(
3)

TODO_DATE_6 DATE

TODO_START_TIME_6 VARCHAR
2(5)

ACTIVITY_CODE_6 VARCHAR
2(30)

INTERACTION_NOTES_7 VARCHAR
2(2000)

PRIORITY_7 NUMBER(
3)

TODO_DATE_7 DATE

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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TODO_START_TIME_7 VARCHAR
2(5)

ACTIVITY_CODE_7 VARCHAR
2(30)

INTERACTION_NOTES_8 VARCHAR
2(2000)

PRIORITY_8 NUMBER(
3)

TODO_DATE_8 DATE

TODO_START_TIME_8 VARCHAR
2(5)

ACTIVITY_CODE_8 VARCHAR
2(30)

INTERACTION_NOTES_9 VARCHAR
2(2000)

PRIORITY_9 NUMBER(
3)

TODO_DATE_9 DATE

TODO_START_TIME_9 VARCHAR
2(5)

ACTIVITY_CODE_9 VARCHAR
2(30)

INTERACTION_NOTES_
10

VARCHAR
2(2000)

PRIORITY_10 NUMBER(
3)

TODO_DATE_10 DATE

TODO_START_TIME_10 VARCHAR
2(5)

ACTIVITY_CODE_10 VARCHAR
2(30)

LEAD_NOTE VARCHAR
2(2000)

Yes

MIDDLE_INITIAL VARCHAR
2(10)

Yes

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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FAX_NUMBER VARCHAR
2(25)

Area code must be 
separated, otherwise the 
whole number will be stored 
in the number column.

FAX_AREA_CODE VARCHAR
2(10)

MAIL_STOP VARCHAR
2(60)

Yes

NUM_ENROLLED NUMBER(
5)

Leave this field null. Obsolete.

CONFIRMED_FLAG VARCHAR
2(1)

Leave this field null. Obsolete.

PAYMENT_AMOUNT NUMBER Leave this field null. Obsolete.

NUM_ATTENDED NUMBER(
5)

Leave this field null. Obsolete.

PROMOTION_NAME VARCHAR
2(240)

Leave this field null. Obsolete.

STATUS_CHANGE_FLAG VARCHAR
2(1)

Leave this field null. Obsolete.

VEHICLE_RESPONSE_
CODE

VARCHAR
2(30)

select lookup_code from as_
lookups where lookup_type 
= ’VEHICLE_RESPONSE_
CODE’ and enabled_flag = 
’Y’

’

SOURCE_SYSTEM VARCHAR
2(250)

Yes select lookup_code from as_
lookups where lookup_type 
= ’SOURCE_SYSTEM’ and 
enabled_flag = ’Y’

CONTACT_PARTY_ID NUMBER

SECURITY_GROUP_ID NUMBER

PRM_SALES_LEAD_
TYPE

VARCHAR
2(30)

Partner specific.

PRM_EXEC_SPONSOR_
FLAG

VARCHAR
2(1)

Partner specific.

PRM_PRJ_LEAD_IN_
PLACE_FLAG

VARCHAR
2(1)

Partner specific.

INCUMBENT_PARTNER_
PARTY_ID

NUMBER Partner specific.

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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INCUMBENT_PARTNER_
RESOURCE_ID

NUMBER Partner specific.

OFFER_ID NUMBER

PRM_IND_
CLASSIFICATION_CODE

VARCHAR
2(30)

Partner specific.

PARTY_TYPE VARCHAR
2(30)

BATCH_ID NUMBER(
15)

Yes as_sl_imp_batch_s. Batch id of the load. 
BATCH_ID must be 
populated in as_import_
interface table before 
running the Import Sales 
Leads concurrent program.

PARTY_ID NUMBER(
15)

Leave this field null.

PARTY_SITE_ID NUMBER(
15)

Leave this field null.

LOCATION_ID NUMBER(
15)

Leave this field null.

REL_PARTY_ID NUMBER(
15)

Leave this field null.

SALES_LEAD_ID NUMBER(
15)

Leave this field null.

ADDRESS_KEY VARCHAR
2(500)

Leave this field null.

CONTACT_KEY VACHAR2(
80)

Leave this field null.

JOB_TITLE_CODE VARCHAR
2(30)

ar_lookups.lookup_code 
where lookup_type = 
’RESPONSIBILITY’ and 
enabled_flag = ’Y’

Stores the job title code.

DO_NOT_PHONE_FLAG VARCHAR
2(1)

Valid values are Y (do not 
phone) or N (OK to phone). 

DO_NOT_FAX_FLAG VARCHAR
2(1)

Valid values are Y (do not 
fax or N (OK to fax). 

DO_NOT_EMAIL_FLAG VARCHAR
2(1)

Valid values are Y (do not 
email) or N (OK to email). 

ORIG_SYSTEM_
REFERENCE

VARCHAR
2(240)

May be populated as <orig_
system_code >:: <identifier> 
example: OTN:10100.

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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If you are importing leads and have flexfield set up in your application you must 
also populate the AS_IMP_SL_FLEX table
:

LEAD_RANK_ID NUMBER(
15)

 as_sales_lead_rank_
vl.rank_id, meaning where 
enabled_flag = ’Y’

Need not supply if supplied 
will get validated.

NEW_PARTY_FLAG NUMBER(
1)

Leave null. DO NOT POPULATE

NEW_LOC_FLAG NUMBER(
1)

Leave null. DO NOT POPULATE

NEW_PS_FLAG NUMBER(
1)

Leave null. DO NOT POPULATE

NEW_REL_FLAG NUMBER(
1)

Leave null. DO NOT POPULATE

NEW_CON_FLAG NUMBER(
1)

Leave null. DO NOT POPULATE

ORIG_SYSTEM_CODE VARCHAR
2(30)

Source application code 
where the lead originated 
example: OTN

Table Column Comment

IMP_SL_FLEX_ID

IMPORT_INTERFACE_
ID

CREATED_BY

CREATION_DATE

LAST_UPDATED_BY

LAST_UPDATE_LOGIN

LAST_UPDATE_DATE

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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ENTITY_NAME Entity Names that are 
supported are HZ_
PARTIES, HZ_
LOCATIONS, HZ_
CONTACT_POINTS, 
HZ_PARTY_SITES, HZ_
ORG_CONTACTS, HZ_
ORG_CONTACT_
ROLES, AS_SALES_
LEADS.

Lookup Type ENTITY_
NAME

VALIDATED_FLAG

TARGET_OBJ_ID

SECURITY_GROUP_ID

REQUEST_ID

PROGRAM_
APPLICATION_ID

PROGRAM_ID

PROGRAM_UPDATE_
DATE

ATTR_VAL_CATEGORY

ATTR_VAL_1

ATTR_VAL_2

ATTR_VAL_3

ATTR_VAL_4

ATTR_VAL_5

ATTR_VAL_6

ATTR_VAL_7

ATTR_VAL_8

ATTR_VAL_9

ATTR_VAL_10

ATTR_VAL_11

Table Column Comment
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ATTR_VAL_12

ATTR_VAL_13

ATTR_VAL_14

ATTR_VAL_15

ATTR_VAL_16

ATTR_VAL_17

ATTR_VAL_18

ATTR_VAL_19

ATTR_VAL_20

ATTR_VAL_21

ATTR_VAL_22

ATTR_VAL_23

ATTR_VAL_24

GATTR_VAL_
CATEGORY

GATTR_VAL_1

GATTR_VAL_2

GATTR_VAL_4

GATTR_VAL_3

GATTR_VAL_5

GATTR_VAL_6

GATTR_VAL_7

GATTR_VAL_8

GATTR_VAL_9

GATTR_VAL_10

GATTR_VAL_11

GATTR_VAL_12

GATTR_VAL_13

Table Column Comment
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25c): Checking for and Correcting Errors in Imported Leads
Use this procedure to check for and correct any errors detected by the Lead Import 
concurrent program during lead import. The errors are stored in the 
AS_LEAD_IMPORT_ERRORS table.

Prerequisite
You must:

■ Import the leads from a flat file or populate the interface table.

■ Run the Lead Import concurrent program. 

Steps
1. If you wish to view a report which details how many leads were successfully 

imported, then:

a. Under the TeleSales Manager responsibility, navigate to Reports > Lead 
Import Report.

b. Enter report parameters and click OK.

2.  Under the TeleSales Administration responsibility, navigate to Lead Import.

The Data Load Maintenance window appears.

3. Find the records with errors using the Query Enter / Query Run search method:

a. From the View menu choose Query by example >Enter.

b. From the Load Status drop-down list, select Error.

c. From the View menu choose Query by example >Run

GATTR_VAL_14

GATTR_VAL_15

GATTR_VAL_16

GATTR_VAL_17

GATTR_VAL_18

GATTR_VAL_19

GATTR_VAL_20

Table Column Comment
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If there are any records with an error, then the window displays the first 
record. The status bar at the bottom of the window tells you how many 
records have errors in all. 

4. Navigate to the record you wish to correct.

5. From the drop-down list in the middle of the window, select Error to view any 
error messages. This error page also tells you when the date and time the error 
was detected.

6. If you wish to correct an error in customer data, then:

a. Select Accounts from the drop-down list in the middle of the window.

b. Make your corrections. 

c. Click Save on the toolbar.

7. If you wish to correct an error in purchase interest or budget information, then:

a. Select Leads from the drop-down list in the middle of the window.

b. Make your corrections. 

c. Click Save on the toolbar.

8. Change the Load Status for the record to New.

9. Click Save on the toolbar.

10. Repeat this procedure for each record with an error.

11. Click Load when you have completed correcting all of the records.

12. Click Yes in the Decision dialog box. This runs the Lead Import concurrent 
program again.

13. After the concurrent program has completed successfully, check to see if there 
are any remaining errors by running another Query Enter / Query Run query 
on Load Status of Error.

Note: You must change the load status of a corrected record to 
NEW for the lead import program to load the lead again.
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About Existence Checking
Before creating a new customer, the lead import program checks to see if a duplicate 
customer name already exists in the database. If a duplicate exists, then the program 
does not create a new customer record. Instead, it creates a lead for the existing 
customer.

If multiple records exist with same name, then the program creates the lead for the 
customer with the highest party_id. Similar checks are done for addresses and 
contacts.

How the Program Checks for Duplicates
The TCA APIs use the word replacement rules to create fuzzy keys. The lead import 
program then uses these fuzzy keys to check for duplicate data. The program 
creates new records according to the following algorithm:

1. If the location does not exist, then create the location.

2. If the party does not exists, then create the party.

3. If the party site does not exist for the combination of party and location, then 
create the party site.

4. If the contact party does not exist, then create the contact party.

5. If the relationship of type CONTACT not exist between party and contact party, 
then create the organizational contact, relationship, and contact roles.

Customer
Existence checking is done using customer_key in HZ_PARTIES. This key is 
generated by TCA APIs while creating the customer.

The Lead Import program populates the AS_IMPORT_INTERFACE table with 
customer keys using TCA APIs for all leads to be imported. Then it compares the 
customer key of the lead to be imported with customer keys in HZ_PARTIES. If it 
finds a match in HZ_PARTIES, then it uses the matching customer. Otherwise it 

Note: The application does not remove the records of past errors. 
This means that if a record still has an error when you run the lead 
import the second time, the same record will show up twice as an 
error. You can tell the most recent version by examining the date 
and time on the error page. 
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creates a new customer using the TCA API. If there are multiple records with same 
customer key, then the lead is created for the customer with the highest party_id.

Any word replacement rules defined in TCA are applied to the customer name in 
the lead import interface table while populating the key in lead import interface 
table.

Address
In the TCA customer model, the address consists of the Party Site in 
HZ_PARTY_SITES and location in HZ_LOCATIONS. Locations is a physical 
address, such as 500 Oracle Parkway, Redwood Shores, CA 94065. The Party Site is 
a logical name associated with a location. For example, the Party Site 
"Headquarters" can be associated with the location 500 Oracle Parkway. Multiple 
party sites can point to same location. For example, 500 Oracle Parkway can be both 
"Headquarters" and "Human Resources". The lead import program checks if a 
duplicate location exists in HZ_LOCATIONS and if the Party Site exists for the 
combination of location and customer in HZ_PARTY_SITES. 

The existence checking is done using address_key in HZ_LOCATIONS. This key is 
generated by the TCA APIs while creating the location. The Lead Import program 
populates the AS_IMPORT_INTERFACE table with address keys using TCA APIs 
for all leads to be imported. It then compares the address key of the lead to be 
imported with address keys in HZ_LOCATIONS.

If a matching record is found in HZ_LOCATIONS, then it uses the matching 
location. Otherwise it creates a new location using the TCA API. If there are 
multiple records with same address key, then the lead is created for the location 
with the highest location_id. 

Once the location_id is created, the program finds out whether a party site exists for 
the combination of this location_id and party_id. If such party site already exists, 
then the lead is created for that party_site_id. If not, then a new party site is created 
using TCA API.

Contact
In TCA, the contact is stored as a party of type "PERSON" in HZ_PARTIES and a 
relationship is created between the customer and contact in 
HZ_PARTY_RELATIONSHIPS. The lead import program checks whether the 
contact exists in HZ_PARTIES (as a party of type "PERSON") and it checks whether 
a relationship of type "Contact" exists between the customer and contact in 
HZ_PARTY_RELATIONSHIPS. The existence checking is done using customer_key 
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in TCA table (HZ_PARTIES). For more details, please refer to the above section on 
customers.

If a relationship of any other type exists, then Lead import program will create a 
new relationship. 

If a contact with same first name and last name (the same party_name) exists in 
HZ_PARTIES, then the lead import program does not create a new contact in the 
TCA tables. It instead creates a new relationship and attaches the lead to that 
contact.

Contact Restrictions
The Lead Import program sets the do_not_phone_flag, do_not_fax_flag, 
do_not_email_flag, and do_not_mail_flag for the contact (relationship party_id). It 
also sets the do_not_mail_flag for the address (party_site).

No existence checking is done.

Contact Points
Lead Import creates Phone, Email, WEB, and Fax. No existence checking is done.

Limitations
The Lead import program cannot identify duplicate records within a batch. This 
means that if the lead import table is populated with two leads for the same 
customer and that customer does not exist already, then lead import will create two 
new customers.

Existence checking for contacts is based only on the name of the contact. This means 
that if John Dow already exist as a person, then lead import will not create a new 
party ’John Dow’ of type "PERSON". It will create new relationship records for each 
customer named ’John Dow’.

You can not bypass Existence checking.

Step 26: Setting Up Sales Online Wireless (Optional)
Follow these steps to set up Sales Online Wireless:

Set Up Sales Online Wireless Application
■ Set the profile JTFW_PROFILE_DEFAULT_WIRELESS_RESPONSIBILITY equal 

to 22726.
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The number 22726 is the responsibility id of "Sales Online Wireless User". Make 
sure you have the responsibility already seeded.

Set Up Wireless Edition Server
1. Install 9iAS Wireless Edition Server.

For detailed information about installing the 9iAS Wireless Edition Server, refer 
to the Oracle 9i Application Server Documentation, Release 1 (v1.0.2.2).

2. Create a service that points to jtfwlgnm.jsp file which is the application HTML 
top.

http://your.middletier.com:PORT/OA_HTML/jtfwlgnm.jsp 
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